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Integration Repository
 The Oracle Integration Repository is a compilation of information about the service 
endpoints exposed by the Oracle E-Business Suite of applications. It provides a 
complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets 
users easily discover and deploy the appropriate business service interface for 
integration with any system, application, or business partner. 

 The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As 
your instance is patched, the repository is automatically updated with content 
appropriate for the precise revisions of interfaces in your environment. 

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Introduction to Demand Management 

Important: The Demantra Local Application replaces Collaborator 
Workbench. You may see both names in this text.

This chapter covers the following topics:

• Introduction

• What is Demand Management?

• Why Manage Demand?

• Typical Tasks in Demand Management

Introduction
Oracle Demantra Demand Management is a configurable Web-based product to help 
your organization perform demand planning and forecasting. Your system has been 
configured to support you and others in your company. Oracle Demantra Demand 
Management provides access to your historical sales data, returns, and other reference 
data organized into multiple hierarchies that reflect the needs of your organization. An 
underlying spreadsheet provides a set of calculated (and input) values that you can use 
at any hierarchy level.

The process of demand planning generally consists of studying historical sales data and
trying to predict future demand as closely as possible. The goal is to achieve an 
appropriate balance between meeting customer demands as quickly as possible and 
making or buying only as much of each product as required. Oracle Demantra Demand 
Management and Demand Planner give you insight into both sides of this trade-off.

A demand plan is based on a forecast, which in turn is a prediction of tendencies in the 
supply chain over a period of time, influenced by seasonal and other predictable factors.
The result of a forecast is a projected curve that has been smoothed to show tendencies 
and deemphasize the exceptional variations.

In general, the demand plan and forecast are used in downstream operations such as 
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production planning. Depending on how your system has been configured, it either 
exports such data automatically or contains reports that you use for that purpose.

What is Demand Management?
Demand Management is used to enable organizations to produce unconstrained 
forecasts for future demand and generate tactical, operational, and strategic business 
plans. Demand Management captures and processes information from multiple sources
and consolidates demand so that it can be summarized by item, product line, region, 
time, and organization.

There are three key areas of focus in improving Demand Management processes. They 
are: achieving consensus, improving accuracy, and reducing process cycle time. Getting 
an entire organization to one expression of "the forecast" is the most important goal of a 
good Demand Management process. This requires the ability to gather and consolidate 
all the sources of demand information. It also requires providing secure, portal based 
access to receive, analyze, and submit forecast data, and the ability to express the data 
in the right format. For example, view forecast by region in dollars, forecast in units by 
shipping facility, and so on.

Why Manage Demand?
While demand is inherently variable and some inaccuracy is inherent, improving 
accuracy is also critical. Improving accuracy requires improvements in several areas. 
For example, organizations use statistics to better estimate patterns, they consolidate 
quantitative and qualitative judgment, and use performance management to drive 
continuous improvement over time. Perhaps the most important area is reducing the 
cycle time of the demand management process. The longer the process takes, the more 
inaccurate it will be, the further in advance of actual events the prediction will be, and 
the process will also become less frequent. Cutting time out requires powerful analytic 
tools to quickly assess and understand demand and automating processes to allow for 
management by exception.

Typical Tasks in Demand Management
At a very high level, you might work with Oracle Demantra Demand Management as 
follows:

1. Log on.

2. Open a worksheet.

3. View the forecast series and other data and work with it in any of the following 
ways, as needed:

• Edit data manually
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• Perform a simulation.

• Perform data approval.

• Export data for downstream use.

4. Log off.
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2
Demand Management Overview

Important: The Demantra Local Application replaces Collaborator 
Workbench. You may see both names in this text.

This chapter covers the following topics:

• Oracle Demantra Demand Management Overview

• Product Family Forecasting Overview

• Configure to Order Overview

• Service Parts Planning and Service Parts Forecasting Overview

• Subset Forecasting Overview

Oracle Demantra Demand Management Overview
Oracle Demand Management is a configurable web-based product to help your 
organization perform demand planning and forecasting. Demand Management is built 
around collaboration, and takes advantage of work flows to automate the Demand 
Management process.

The process of demand planning generally consists of studying historical sales data and
trying to predict future demand as closely as possible. The goal is to achieve an 
appropriate balance between meeting customer demands as quickly as possible and 
making or buying only as much of each product as required. 

A demand plan is based on a forecast, which in turn is a prediction of tendencies in the 
supply chain over a period of time, influenced by seasonal and other predictable factors.
The result of a forecast is a projected curve that has been smoothed to show tendencies 
and deemphasize the exceptional variations.

In general, the demand plan and forecast are used in downstream operations such as 
production planning. Depending on how your system has been configured, it either 
exports such data automatically or contains reports that you use for that purpose.
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The Demand Management Process
Demand Management is an iterative process, that typically takes place in the weekly, 
biweekly or monthly cycles. This process includes:

1. Collecting the appropriate data from an ERP or other system of record.

2. Downloading the appropriate data to the Demantra database.

3. Generating a forecast and then sending a notification to demand analysts.

4. Demand analysts work with the forecast and making any corrections or 
adjustments.

5. Demand manager or designated forecast owner approves the forecast. 

6. The approved forecast is uploaded to your ERP system.

Collect and Download Data
Most businesses have a regularly scheduled Demand Management process that can be 
monthly, weekly or, in a few cases, daily. During this period, data from various sources 
are loaded into the Demand Management system for use in forecasting future demand. 
The source systems can be an ERP system, legacy system or another Oracle APS 
(Advanced Planning Suite) module such as Advanced Supply Chain Planning, 
Inventory Optimization, Global Order Promising or Collaborative Planning.

Once loaded, the administrator ensures that planners have access to the data they 
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require. For example, each planner may be responsible for planning the demand for a 
particular region or product line. Although planners can view data for all lines of 
business they are given access to, they are only able to modify data for which they have 
permissions.

Generate the Forecast and Send Notifications
After the download is complete, the administrator (or an automated process) runs the 
forecast and resets the approval series. After successful calculation of the forecast, the 
appropriate users are automatically notified that their forecast is available for review. 
The forecast, forecast accuracy measures and Demand Priority information are available
in predefined worksheets for analysis for all users.

Note: In the event of an unsuccessful download or forecast generation, 
the Administrator can check the batch log for information on problems 
that arose during processing and forecast generation.

Manage and Approve the Forecast
The approval process is built around two user-types: the Demand Administrator and 
Demand Analyst. During implementation, Demand Administrators configure the 
approval process by specifying a reviewer who has final approval of the forecast. Each 
group of Demand Analysts should have one final approver. 

At the start of the approval process, a notification appears in the My Tasks window 
informing Demand Analysts that a forecast is available for the current planning cycle. 
Analysts can review their planning data (including the forecast) using one of the 
pre-seeded worksheets:

• Waterfall Analysis: Product Category and Zone

• Waterfall Analysis: Product Category and Organization

• Demand Analysis: Product Category and Organization

• Demand Analysis: Product Category and Zone

• Demand Analysis: Item and Organization

• Demand Analysis: Item and Zone

Using the graphs and reports found in these worksheets, analysts view and adjust their 
forecast data. They analyze history to understand shipped, booked and customer 
orders, inventory levels and other factors. For example, an analyst may consider any 
upcoming events or promotions that may impact the demand as well as their customer 
and sales forecast. 

Based on this information, analysts modify the forecast and can run a simulation that 
repopulates the worksheet with the changed data. Once their analysis and 
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modifications are complete, the analyst saves the changes and selects Done for the 
relevant notification in the Collaborator Workbench's My Tasks view, which notifies the
demand plan manager or administrator.

These changes to the forecast are available for review by an approver. One or more 
people can do the review. For example, if the analysts are responsible for demand by 
region, a regional manager may approve or change the analyst's changes. Or, if an 
analyst's responsibility is broken down into product lines, then the product line 
manager may have final approval. Demand Management's pre-seeded approval process
is setup for one level of review. Additional levels of review require changes to the 
pre-seeded Approval workflow.

The final approver can lock the forecast at any time by checking the Final Approval 
column. After review, the final approver accepts the forecast by selecting the Done 
button in My Tasks for the forecast notification.

Upload the Forecast
Once approved, the Demand Administrator uploads the consolidated forecast for use in
other systems (for example, Oracle Advanced Supply Chain Planning) where the 
unconstrained demand is used to drive the constrained demand.

Demand Management for Multiple Lines of Business
An organization's data is typically divided into several Lines of Business (LOB). For 
example, a printer manufacturer may have Printers and Copiers lines of business. 
Different lines of business generally have different demand management processes. The
difference in the planning process may be due to the following reasons:

• Each line of business may have different planning cycles (such as weekly or 
monthly) and may use different calendars (such as manufacturing or fiscal).

• Each line of business may have different business requirements, such as 
model-options forecasting, product family level forecasting, service parts 
forecasting, and so on.

• The lines of business may be in different geographical locations or may otherwise 
have varying business practices.

• Each line of business may have its separate group of planners who need to look at 
the demand data pertaining to their respective line of business only.

• A line of business demand plan refers to limiting the scope of a demand plan to 
include only those level values (such as items, organizations, customers' ship to 
locations, sales representatives) that pertain to the line of business. 

When an organization has multiple LOBs, the data is often assigned to specific users 
(for example based on product line or region), and the analyst is responsible for 
determining the demand for that slice of data. When each analyst has reviewed and 
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approved his or her forecast, a master approver is notified and approves the forecast as 
a whole.

The following diagram illustrates the demand management process with multiple lines 
of business:

Product Family Forecasting Overview
A product family bill of material is typically made up of a product family item at the 
top level and items (children) one level down

This is a sample product family bill of material,

Automobiles

. Sedan

. Coupe

. Sports

For product family planning, all the family members of a product family must:

• Be either planned individually or as product family.

• Have the same value for item attribute Forecast Control: Either None or Consume &
Derive

• Be standard items

If the item level does not have enough data to produce an accurate forecast, Oracle 
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Demantra Demand Management forecasts at the Product Family level and allocates the 
product family forecast down to the children. 

Configure to Order Overview
Configure to order products are configurations of components depending on the 
customer's preference. In most cases, this includes a selected base product (the model) 
and multiple optional (the options) and mandatory components.

Configure to order works on the principle of dependent demand forecasting. 
Dependent Demand Forecasting is the capability to forecast demand for partially or 
fully dependent products whose demand depends wholly or partially on the demand 
for another product. Some of the typical questions that are addressed by dependent 
demand forecasting are:

• To an automobile manufacturer: How many alloy wheels or V6 engines would be 
sold?

• To the personal computer manufacturer: How many total hard disks would need to
be manufactured? Of those, how many would sell as part of a new personal 
computer and how many would sell individually?

Configure to order products are also known as models. There are products, for example
personal computers, whose:

• Optional items are assembled to customer requirements: For example, personal 
computer options may include monitors and keyboards

• Options' demand is dependent on the model's demand: For example, desktop 
personal computers may require monitors

The probability of an option is the likelihood that an item will be purchased when 
another item is purchased. For:

• Mandatory items, the probability is 100%

• Options, the probability comes from the sales history.

These inter-item probabilities can also vary across regions and across sales channels as 
customer preferences vary.

The probabilities become planning percentages on the mandatory components and 
options that help derive the forecasted demand for them.

The demand planning process for configure to order includes these processes:

• Demand Planning and Management for Finished Goods: The process to agree to the
future unconstrained demand plan for the models, based on inputs from 
management of new activities, Sales, Marketing, and historical data.
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• Demand Planning and Management for Components: The process that predicts the 
mix of the mandatory components and options. It multiplies the final consensus 
plan for the models by the planning percentages on the mandatory components and
options. This process is not part of the supply planning process because these 
relationships are characteristic of the demand planning process, for example, the 
effects of promotions and other demand planning activities on the option mix and 
the effect of the option mix on revenue.

Generally, if you are operating with configurable models and options, you follow the 
typical Oracle Demantra Demand Management process with some changes for 
configure to order products. In general, the business flow is:

• Derive a model forecast from the sales histories of models

• Calculate item-level forecasts for options and mandatory items by applying 
planning percentages to the model forecast.

• Analyze and update item-level forecasts as required in multiple dimensions to 
reach a consensus

• Publish the final forecast for supply planning.

Configure to Order Structure

The configure to order structure is typically:

. Base Model

..Option Classes

… Options (Buildable items)

..Mandatory Components (Buildable items)

Note: Whether option classes are included or not is determined by the 
setting of the profile MSD_DEM: Calculate Planning Percentages.

A base model bill of material is typically made up of:

• The base model

• Options that are grouped into option classes: An option class is not a buildable or 
saleable item. For each option class, the customer may choose one or more of the 
options. An option can be another model.

• Mandatory components/included items: These are included as part of all models

This is a sample base model bill of material. 

Sedan

.. Tires
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… Standard

… Long Life

.. Seats

… Cloth

… Leather

… Vinyl

.. Roof Rack

… Luggage Style

… Bicycle Style

.. Operating Manual

The base model is Sedan. In the Sedan bill of material, the:

• Option classes are Tires, Seats, and Roof Rack

• Options are Standard, Long Life, Cloth, Leather, Vinyl, Luggage Style, and Bicycle 
Style

• Mandatory component is Operating Manual

Base models can be of these types:

• Assemble to order: The manufacturer or distributor assembles the components and 
ships the configured item, for example, an automobile. 

• Pick to order: The components are shipped separately and assembled by the 
recipient, for example, a children's outdoor play set. 

Planning Percentages

The makeup of the modular products is represented both by model bills and the ratio of
the sales of options to the sales of models.

Oracle Demantra generates the independent demand forecast for an item, typically the 
base model, on the basis of the independent history for the item.

Each component item in a model bill of material has a planning factor. The planning 
factors are the attach rates, or ratios of options to model demand, that is, the percentage 
of time that customers order that component item when they order the model.

These ratios, called planning percentages, express the relationship of options to the 
models. They need to be derived in the demand planning process where changes in 
product mix can affect the demand related to a forecast. Also, promotions and other 
demand planning activities can change the options that are being sold.

Estimating model demand is not enough but predicting the mix of options or features 
based on their relative sales is necessary using historical percent--the average historical 
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sales of options to models:

Note: Refer to system parameters "CTO_Enable_Worksheet_Calculations" and 
"CTO_PLANNING_PERCENTAGE_CHOICE" documented in the Oracle Demantra 
Implementation Guide.

Bill of Material Explosion

Oracle Demantra calculates the dependent demand forecast for a dependent item 
(option class, option, mandatory component) by exploding the forecast from its 
respective parents using the corresponding bills of material. Dependent demand for an 
item is calculated by multiplying its planning percentage by the demand at the next 
highest level in the bill of material. Dependent demand items can also have an 
independent demand forecast, for example, the service parts portion of their demand 

The total demand for any item is the sum of the dependent and independent 
components of demand. For example, the demand for computer monitors is a 
composite of its direct (independent) demand and the demand deriving from the sale of
personal computer systems (dependent demand).

This table shows a sample base model bill of material with the items, the planning 
percentages, and the results from the model bill of material explosion

Bill of Material Item Planning 
Percentage

Demand Explosion 
Calculation

. Sedan - . 500 (forecast) -

.. Tires ..100% .. 500 ..500 * 1

… Standard set .. 75% … 375 … 500 * 0.75

… Long Life set .. 25% … 125 … 500 * 0.25

.. Seats ..100% .. 500 .. 500 * 1

… Cloth … 10% ... 50 … 500 * 0.1

… Leather … 45% … 225 … 500 * 0.45

… Vinyl … 45% … 225 … 500 * 0.45

.. Roof Rack .. 35% .. 175 .. 500* 0.35

… Luggage Style … 60% … 105 … 175 * 0.6
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Bill of Material Item Planning 
Percentage

Demand Explosion 
Calculation

… Bicycle Style … 40% … 70 … 175 * 0.4

.. Operating Manual .. 100% .. 500 .. 500 * 1

Moving Configure to Order Data from Oracle e-Business Suite to Oracle Demantra

Data that moves from Oracle e-Business Suite to Oracle Demantra includes:

• Item master information

• Option attributes 

To move configure to order data from Oracle e-Business Suite into Oracle Demantra, 
use a two-stage process:

• Collections: Collect Shipment and Booking History process

• Download: EBS Full Download and Import Integration Profiles process

Note: The MSD_DEM: Calculate Dependent Demand profile must be 
set to Yes in order for the BOMs to be collected.

Configure to Order Levels

Configure to order information is stored by the item and organization in the source and 
downloaded into the lowest levels of all the dimensions. For example, if the planing 
percentage for an item-org combination is 50%, all the other lowest level dimensions 
will show 50% for the planning percentage.

Configure to order structures work with these levels: 

• Item: Item lowest level for configure to order demand.

• Demand Class: Item lowest level for classifying configure to order demand 

• Base Model: Configure to order item lowest level that allows demand for multiple 
(Item, Parent) combinations to be planned for multiple root models.

• Parent Item: Configure to order item lowest level that allows demand for the same 
item to be planned in the context of multiple parents (Item, Parent). Although the 
Parent Item object is not part of the bill of material, the option's parent is specified 
in the BOM.
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For example, there is a bill of material structure

Computer Package A

. Laptop A1

.. Option Class HardDisk

... Harddisk 120G

... Harddisk 150G

.. Option Class Processor

... Processor Pentium 2GHz

... Processor AMD 2GHz

The level load contains these entries

Item (Option) Parent (Option Class) Base Model

Harddisk 120G HardDisk Computer Package A

Harddisk 150G HardDisk Computer Package A

Pentium 2GHz Processor Computer Package A

AMD 2GHz Processor Computer Package A

Configure to Order Options
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If a base model has history, all its options are loaded into Oracle Demantra.

Option information for Oracle e-Business Suite is dimensioned by the item and 
organization level. This information needs to be associated to the other dimensions, for 
example site and demand class, when stored and planned in Oracle Demantra.

Configure to Order Sales History 

The Collect Shipment and Booking History process includes configure to order history.

It uses profile option MSD_DEM: Include Dependent Demand. Set it to Yes for the 
process to collect the bills of material for configure to order.

The process collects bills of material that are active within the Shipment History time 
span (or the time span of other selected series). The bill of material start date is required,
but not the end date.

It calculates dependent demand through the bill of material effective end date, if there is
a value on the bill of material. If there is no end date, it calculates dependent demand 
through the last time period of the forecast.

It loads the History Dependent Demand series from the history of options. The series 
that is loaded into History Dependent Demand is determined by the independent 
demand history series in Oracle Demantra. The default is Shipment History - requested 
items - shipped date.

Note: Refer to system parameter "CTO_HISTORY_PERIODS" documented in the Oracle 
Demantra Implementation Guide.

The series available for configure to order collections are:

• Dependent Booking - booked items - booked date 

• Dependent Booking - requested items - booked date 

• Dependent Booking - booked items - requested date

• Dependent Booking - requested items - requested date 

• Dependent Shipping - requested items - shipped date (default) 

• Dependent Shipping - shipped items - requested date 

• Dependent Shipping - requested items - requested date 

For every series that you mark Yes on the Collections parameter window, it loads the 
shipment and booking history of the options as follows:

• The name of the series is the same as the marked series with - Dependent Demand 
appended, for example, you select series Booking History, the dependent demand 
is in series Booking History - Dependent Demand

• The exception is for the default series; its dependent demand is in series History - 
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Dependent Demand

The process only includes configured items with these attributes:

• Autocreated Configuration: No; this excludes configuration items

• Assemble to Order: Yes

• Pre-specified popular configurations

For example, there is a bill of material structure

Computer Package A

. Laptop A1

.. Option Class HardDisk

... Harddisk 120G

... Harddisk 150G

.. Option Class Processor

... Processor Pentium 2GHz

... Processor AMD 2 GHz

The sales history load contains these entries

Item Parent Item Base Model Date Quantity

120G Harddisk Computer 
Package A

1/1/2008 1

Pentium 2 GHz Processor Computer 
Package A

1/1/2008 1

Harddisk Laptop A1 Computer 
Package A

1/1/2008 1

Processor Laptop A1 Computer 
Package A

1/1/2008 1

Laptop A1 Computer 
Package A

Computer 
Package A

1/1/2008 1

Computer 
Package A

Computer 
Package A

Computer 
Package A

1/1/2008 1

Viewing Bill of Material Information in Worksheets
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To include a bill of material tree in a worksheet, follow these steps:

1. In the Aggregation tab, select the Base Model, Parent Item, and then Item

2. In the Layout tab, right-click the item level and select Show BOM Tree.

The system uses a parent level and a child level to display the bill of materials tree in 
the worksheet. You can see these levels in the Aggregation Tab:

• CTO Parent

• CTO Child 

In any worksheet with the Show BOM Tree option enabled, you can create additional 
views. The bill of materials tree is then enabled in every additional view. Conversely, if 
you disable the Show BOM Tree option in any view, it is disabled in every view in the 
worksheet.

You can add notes to any item that is an option or option class displayed in the bill of 
materials tree. When you right-click and select Notes for an option or option class in the
bill of materials tree, the note appears on that option or option class when the bill of 
materials tree is displayed.

If the item is not displayed in the bill of materials tree format (for example, item's 
dependant demand across all base models and independent demand), all notes 
assigned to that item in the bill of materials tree are visible.

In all display formats, the display:

• Always includes independent demand

• Includes dependent demand when it is a calculation that depends on the parent 
demand relationships in the bill of material
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If you do select Show BOM Tree, you see the bill of material in indented fashion.

If you do not select Show BOM Tree and Item on the crosstab, you see the bill of 
material as a flattened list of all levels.
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If you do not select Show BOM Tree and both Item and Parent Item are on the crosstab, 
you see a typical crosstab without multi-level recursion of the bill of material.
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 If you want to display information grouped by level, a new level can be added to the 
CTO levels. For example, you can add a new level if you want to view all the BOMs for 
base models in the Product Family server, a CTO level called BM Product Family can be
created during implementation and placed to the right of the BOM tree (associating the 
base models to the Product Family server is also an implementation task).

Creating a Product Family Level

A level is usually placed to the right of the BOM tree for information purposes, such as 
viewing associated level values. You can do this by creating a series on the level in the 
Business Modeler.

1. In the Business Modeler, click the Series icon.

2. Click the New icon.

3. In the General Properties tab, enter the following:

• Enter the Series name

• Editable = No

4. In the Display Properties tab, enter the following:
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• Table only

• No summary

5. In the Data Properties tab, enter the following:

• Data Table = Level. For example:

<Level> Product Family

• Aggregation Function = MIN

6. In the Expression Properties tab, enter the following:

• Server Expression = Select relevant table for MIN function. For example:

min (t_ep_ebs_prod_family.ebs_prod_fmly_desc)

7. Click Save.

Editing Planning Percentages in a Worksheet

An option-class item combination may be part of the configuration of more than one 
base model.

After the initial download of planning percentages, the planning percentage for an 
option class-item combination in multiple base models is the same.

If you use a worksheet to edit an option class-item combination that is in multiple base 
models, the planning percentages that result can be different depending on whether or 
not the base model in included in or excluded as a dimension from the worksheet.

Note: Refer to system parameter "CTO_Enable_Worksheet_Calculations" documented 
in the Oracle Demantra Implementation Guide.

This example shows two central processing unit base models after the initial download 
of planning percentages.

Bill of Material Item Planning 
Percentage

Bill of Material Item Planning 
Percentage

. CPU 1 (model) - . CPU 2 (model) -

.. Drives (option class) ..100% .. Drives (option class) 100%

… Hard drive 120g .. 40% … Hard drive 120g … 40%

… Hard drive 220g .. 60% … Hard drive 220g … 60%
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Base Model is a Worksheet Level:

In this example:

• The worksheet levels are Base Model, Option Class, and Item

• You change the planning percentage for Model CPU 1 > Option class Drives > Hard 
Drive 220g from 60% to 80%

Bill of Material Item Planning Percentage

. CPU 1 (model) -

.. Drives (option class) ..120%

… Hard drive 120g .. 40%

… Hard drive 220g .. 80%

Continuing with this example where base model is a worksheet level:

• Since base model is an included level in the worksheet, the planning percent for 
Model CPU 2 > Option class Drives > Hard Drive 220g remains at 60%

• For exporting the option class-item combination to Oracle Advanced Supply Chain 
Planning, Oracle Demantra averages the multiple planning percentages and exports
the average. In this case, it exports 70% for Option class Drives > Hard Drive 220g 
[(80 + 60) / 2 = 140 / 2].

Bill of Material Item Planning 
Percentage

Bill of Material Item Planning 
Percentage

. CPU 1 (model) - . CPU 2 (model) -

.. Drives (option class) ..120% .. Drives (option class) 100%

… Hard drive 120g .. 40% … Hard drive 120g … 40%

… Hard drive 220g .. 80% … Hard drive 220g … 60%

Base Model is Not A Worksheet Level:

In this example:

• The worksheet levels are Option Class and Item
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• You change the planning percentage for Option class Drives > Hard Drive 220g 
from 60% to 80%

Bill of Material Item Planning Percentage

.. Drives (option class) ..120%

… Hard drive 120g .. 40%

… Hard drive 220g .. 80%

Continuing in this example where base model is not a worksheet level:

• Since base model is not an included level in the worksheet, the planning percent for 
Model CPU 2 > Option class Drives > Hard Drive 220g also changes to 80%

• For exporting the option class-item combination to Oracle Advanced Supply Chain 
Planning, Oracle Demantra exports the common planning percentage. In this case, 
it exports 80% for Option class Drives > Hard Drive 220g.

Bill of Material Item Planning 
Percentage

Bill of Material Item Planning 
Percentage

. CPU 1 (model) - . CPU 1 (model) -

.. Drives (option class) ..120% .. Drives (option class) 100%

… Hard drive 120g .. 40% … Hard drive 120g … 40%

… Hard drive 220g .. 80% … Hard drive 220g … 80%

Simulations

You can run simulations to get an approximate forecast based only on the current 
worksheet as opposed to all the data.

When you make a change to Dep Demand - History that affects the forecast, for 
example overriding the history of a model or an option and accept the simulation, the 
simulation process:

• Generates a new forecast

• Recalculates the planning percentage
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• Recalculates dependent demand for affected cells

Note: The Plng Pct Choice must be History for this to occur.

When you make a change to Dep Demand - Existing that affects the forecast, for 
example overriding the history of a model or an option and accept the simulation, the 
simulation process:

• Generates a new forecast

• Keeps the planning percentage

• Recalculates dependent demand for affected cells

Note: The Plng Pct Choice must be Existing for this to occur.

Overrides

You can make changes to the planning percentages, dependent demand and, 
independent demand (forecast) by overriding any of these three series via the 
corresponding override series, for example, Planning Percentage Override.

You can make changes at any depth level of the bill structure. The changes propagate 
through the entire bill structure or if an option class is changed, the changes propagate 
to the children of the option class; you do not have to make any additional manual 
changes.

Settings for Planning Percentages and Dependent Demand

You must instruct e-Business Suite to collect configure to order structures, demand, and
history.

• You can specify the planning percentages to use. Your options are Existing 
(downloaded from the source) or History (calculated in Demantra).

• You can specify the number of history periods to use when calculating planning 
percentages based on the history of the options.

• You can specify where to calculate dependent demand and derive planning 
percentages. Your options are each organization, or globally.

For more information, see Setting up Configure to Order in Oracle Demantra 
Implementation Guide.

Planning Percentage Calculation Based on Sales History Options

The historical planning percentages do not change with time and the same planning 
percentages are used for all the forecasting periods.

For example, if there is a forecast for January 2009 and February 2009 based on history, 
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the calculation of the options' dependent demand for both January 2009 and February 
2009 use the same planning percentages.

Planning Percentage – History = 
Average(option's history/parent's history for CTO_HISTORY_PERIODS). 

The process does not calculate planning percentages prior to an item's BOM Effective 
Start Date or after an item's BOM Effective End Date.

It calculates planning percentage for all the active items to the lowest levels of the bill of
material.

Dependent Demand Calculation Based on Planning Percentages

The dependent demand calculation for options and items is based on the base model's 
information.

It occurs at the following stages:

• After the forecast engine process generates the base models

• Any time that you change base model information

The calculation propagates changes in the intermediate level data to all the children of 
that level. 

Dep Demand – Existing =
Plng Pct- Existing * Immediate parent forecast

Dep Demand – History =
Plng Pct- History * Immediate parent forecast

Forecast Dependent Demand =
Final Plng Pct  * Immediate parent forecast

Final Forecast Dependent Demand = 
If there is a value in Forecast Dependent Demand Override, it is the 
Forecast Dependent Demand Override value. Otherwise, it is the value of 
Forecast Dependent Demand.

Forecast Calculations

For global forecasting:

• Calculate planning percentages at the global level. 

• Aggregate the sales history of the parent item or base model across all the 
organizations 

• Calculate planning percentages at the All Organization level 

• Use the same planning percentages for all the organizations

• If the dependent demand or the planning percentages are modified in a worksheet 
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for an organization, the demand for all other organizations is affected.

For product family forecasting:

• Generate a statistical product family forecast using product family demand

• Allocate the product family forecast to the member item forecasts

Configure to Order MAPE Calculation

The series MAPE CTO holds the results of the MAPE CTO procedure that calculates the
accuracy statistics for Consensus Total Demand. This provides the information 
Inventory Optimization requires to calculate Safety Stock. The calculation is:
sum(abs(Total History – Archived Consensus Total Demand))/sum(History)

where

- Total History = History + Final Forecast Dependent Demand  for the 13 
week period of the archived forecast

- Consensus Total Demand = Independent Demand + Dependent Demand

See Also

Configure to Order Worksheets, page 4-21

Configure to Order Series, page A-14

"Setting Up Configure to Order" in the Oracle Demantra Implementation Guide for more 
information about integrating with EBS and non-Oracle systems.

Service Parts Planning and Service Parts Forecasting Overview
Service Parts Planning

Repair service operations need service parts planning systems to ensure that the right 
parts are at the right locations, at the right times, and in the right (usable) condition, 
while being consistent with inventory budgets and service level targets.

Service parts inventory management differs from product inventory management; 
hence the need for functionality designed to handle special service parts situations such 
as: supersession and intermittent demand.

The Oracle Service Parts Planning solution supports the following forecasting modes:

• Traditional

A demand planning system generates a demand forecast that serves as a demand 
schedule input to the service parts plan, and where implemented, also to the 
inventory optimization plan. The demand planning system also generates a returns 
forecast that serves as a supply schedule input to the service parts plan.

• Inline

Service Part Planning uses Oracle Demantra Demand Management functionality to 
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generate the service parts demand.

In either mode, forecasts can be based on usage history or shipment history.

In the case of new product introductions or similar situations where there is insufficient 
history for a reliable basis, the inline mode provides the ability to base forecasts on the 
item's install base population and average failure rate. 

This document describes the inline scenario, in which Demantra generates the service 
parts forecast and it is then exported for use in Oracle Service Parts Planning or other 
legacy application.

For more information about Oracle Service Parts Planning, Oracle Field Service Spares 
Management, or Oracle Depot Repair, refer to the appropriate Oracle product 
documentation. 

Service Parts Forecasting

Demantra forecasts demand for service parts using two methods. One method uses 
analytical models, and the other method is calculated using install base data and failure 
rates. Demantra generates forecasts using both methods and then allows you to select 
the preferred forecast based on past experience, industry-specific knowledge, or other 
information.

By applying a service part specific failure rate to the projected install base at an 
organization, it is possible to project future demand for service parts.

Failure Rates

Failure rates are based on a comparison of the supported units for the finished good 
and a specific quantity of service parts that are used to service them. A seeded process 
calculates the ratio between the number of supported base models and usage. The result
of the process is the failure rate.

The level at which these values are calculated can vary by business requirement and is 
configurable as part of an implementation. It is possible to calculate failure rates at very 
granular levels. This results in planning percentages that closely reflect part usage for a 
specific spare and location. However, this method is also susceptible to large variations 
in demand over time that are due to inherent intermittent part usage. It is also possible 
to calculate failure rates at more aggregate levels; here the rates generated are more 
generic but are less susceptible to variation.

When generated in aggregation all underlying combinations are assigned the same 
failure rate.

For more information about how to configure the failure rate calculation, refer to Oracle 
Demantra Implementation Guide.

Process Overview

The following example describes a typical Service Parts Forecasting cycle:

• Data, such as service items, usage history, install base details, and details, are 
imported from a source system (for example, Oracle Service Parts Planning) into 
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Demantra.

• The Demantra analytical engine generates a forecast at the spare/org level and 
another forecast is calculated based on projected install base information and failure
rates. 

• Demantra stores the new forecast values in the following series:

• SPF Baseline Forecast

• SPF Calculated Forecast

• Using values stored in the series above, Demantra automatically calculates values 
for the following series:

• SPF Forecast MAPE (In Sample) 

• SPF Forecast MAPE (Out of Sample)

• SPF Forecast Volatility

• SPF Average Demand

These series are described in Service Parts Forecasting Series, page A-17 in 
Appendix A.

Note: Forecast accuracy measures can be viewed at any 
aggregation level, but by default they are calculated at the 
Spare/Organization level. When viewed above this level in a 
worksheet the values will be aggregated to the selected level. 

• Using predefined or custom worksheets, demand analysts review the values these 
series, analyze the install base and failure rate values, optionally make adjustments, 
and run simulations to model different scenarios. When the desired scenario is 
achieved, the user saves changes to the worksheet and accepts the simulation 
results. 

During this process, the following series can be overridden:

• SPF Item Usage or SPF Item Shipments (historical demand) 

• SPF Failure Rate % 

• SPF Install Base 

• SPF Calculated Forecast

•  SPF Baseline Forecast
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Changes to the failure rate or install base are immediately reflected in a revised SPF 
Calculated Forecast value.

• An analyst optionally changes the default value of the "SPF Forecast Method" series.
This setting controls which forecast populates the "SPF Final Forecast" series and 
will eventually be exported to downstream applications, such as Oracle Service 
Parts Planning (SPP). 

• An analyst may manually upload incremental changes made in a worksheet to the 
Demantra staging tables and from there to Service Part Planning; this is done by 
invoking a method from within a worksheet. For more information about this 
method, refer to the Oracle Demantra Implementation Guide.

• The preferred (final) forecast and other metrics are exported to the Demantra 
staging tables using workflows.

• An administrator from the external system executes the required process(es) to 
import the final forecast and metrics from the Demantra staging tables into the 
external system's database tables.

• The forecast and metrics are used by the external system, such as to trigger 
exceptions or as an input to other custom processes.

For more information about Service Parts Forecast worksheets, refer to Service Parts 
Forecasting (SPF) Worksheets, page 4-25. 

Subset Forecasting Overview
There may be times when you do not want to perform a full batch engine run when 
executing the forecasting engine. For example, some environments are too large to 
process all of the available forecast combinations in a single weekend. Or you may not 
want to refresh the forecast for all combinations every forecasting cycle. 

Subset forecasting provides functionality which will generate a batch forecast for a 
filtered subset of combinations. This run will not advance forecast versioning and will 
simply override the latest forecast for the specified subset. This is similar to executing 
and accepting a simulation but without the need to open a worksheet and with the 
benefit of processing parallelization. Subset forecasting does not entirely replace full 
batch runs, as they are required to drive forecast versioning. 

For more information about subset forecasting, see "Forecast Modes" in the Oracle 
Demantra Analytical Engine guide.
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3
Running Simulations

Important: The Demantra Local Application replaces Collaborator 
Workbench. You may see both names in this text.

This chapter covers the following topics:

• Overview of Forecasting

• Viewing Forecast Details

• Running Simulations

• Checking the Simulation Queue

• Canceling a Simulation

Overview of Forecasting
The process of forecasting depends on the following implementation-specific factors:

• How often the Analytical Engine has been set up to run and generate the forecast 
series

• Which series your organization uses

• Which users have access to those series

However, the general process is roughly as follows:

1. Periodically, after the engine has run, open worksheets that contain the forecast 
series and any related series

2. View the demand and forecast series that were created for your implementation. 
Make adjustments as needed.
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Viewing Forecast Details
When the Analytical Engine is run, Oracle Demantra records information about the 
engine run.

To view forecast details

1. Click Data > Forecast Detail.

Oracle Demantra Demand Management displays a popup window that contains 
details about the most recent times it generated the forecast. The upper part of the 
window lists the recent runs of the Analytical Engine.

This table includes the following information:

• Date when the Analytical Engine was run

• Total length of time during which the Analytical Engine ran

• Status of the engine run

• Starting and ending date of the history used to generate the forecast

• Starting date, ending date, and number of base time buckets within the forecast

2. Click a row in the upper part of the window.

The lower part of the window displays further details about the selected forecast.

Running Simulations
You can run simulations to get an approximate forecast based only on the current 
worksheet. (In contrast, when the Analytical Engine runs, it considers all the data in the 
system.)

To run a simulation

1. Make sure the engine process (in Simulation mode) is running on the server. Also 
note that an error will occur if the Analytical Engine has not been run previously.
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2. Run a worksheet.

3. Optionally make a change that could affect the forecast.

4. Click Data > Run Simulation. Or click the Simulation button.

The Select Simulation Type page appears.

Note: Select one of the following simulation types:

5. Select one of the following simulation types:

Option Generates a simulation 
for...

Notes

Selected Page Item Combination that you have 
currently selected in the 
Members Browser or 
selector lists.

If a level is on a worksheet 
axis, these two options are 
different. Otherwise they are
the same.

Selected Combination Combination that you have 
currently selected within the
worksheet table.

If a level is on a worksheet 
axis, these two options are 
different. Otherwise they are
the same.

Whole Worksheet All combinations in the 
worksheet.

This option takes longer to 
run.

6. Select the engine profile that includes the engine settings to use during this 
simulation run. Which profiles you see in the list depends on which simulation and 
forecast series are in the worksheet. For details on the engine profiles in your 
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system, contact your Oracle implementor.

7. Do one of the following

• Click OK to run the simulation.

• Click Cancel to close the page without running the simulation.

8. When the simulation is complete, Oracle Demantra Demand Management displays 
a message. 

9. Do one of the following:

• To accept the results, click Data > Accept Simulation. Oracle Demantra copies 
the data from the Simulation series into the Sales Forecast series, where they are
visible to other users.

• To reject the results, click Data > Reject Simulation. Oracle Demantra clears the 
data from the Simulation series. 

Checking the Simulation Queue
When you start a simulation, Oracle Demantra Demand Management adds it to an 
internal queue, which processes all simulations in the order they are submitted. You can
view this queue and you can cancel a simulation that you submitted.

To check the simulation queue

1. Click Data > Simulation Queue.

Oracle Demantra Demand Management displays the Simulation Queue dialog box.

The Status field indicates the status of each simulation request. The status can be 
one of the following:

Requested A user has submitted this simulation 
request, which has not yet started running.
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Running Oracle Demantra is preforming this 
simulation.

Completed Oracle Demantra has completed this 
simulation successfully.

Stopping A user asked to cancel this simulation 
request, which Oracle Demantra has not yet 
fully canceled.

Stopped A user has canceled this simulation request 
and Oracle Demantra has fully canceled it.

Failed Oracle tried to run this simulation, but an 
error occurred.

Canceling a Simulation
To cancel a simulation

1. Click Data > Simulation Queue.

2. Click simulation and then click Cancel Simulation.
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4
Demand Management Worksheets

Important: The Demantra Local Application replaces Collaborator 
Workbench. You may see both names in this text.

This chapter covers the following topics:

• Worksheets Overview

• New Product Launch Management Worksheet

• Configure to Order Worksheets

• Service Parts Forecasting (SPF) Worksheets

Worksheets Overview
To manage or view forecasts and demand, you start in the Collaborator Workbench and
launch any of the relevant Demand Management worksheets. Worksheets with the 
necessary series for analysis and modification of the forecast are available for the 
analyst at the beginning of each cycle.
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Worksheet Description

Waterfall Analysis: Product 
Category and Organization

Compare actual versus forecast demand, aggregated by 
product category and organization, to determine prior 
periods forecast accuracy.

Waterfall Analysis: Product 
Category and Zone

Compare actual versus forecast demand, aggregated by 
product category and zone, to determine prior periods 
forecast accuracy.

Demand Analysis: Product 
Category and Organization

Compare history and demand data in weekly time 
buckets, aggregated by product category and 
organization. Use this worksheet to manage and approve 
the forecast. 

Demand Analysis: Product 
Category and Zone

Compare history and demand data in weekly time 
buckets, aggregated by product category and zone. Use 
this worksheet to manage and approve the forecast.

Demand Analysis: Item and 
Organization

Compare history and demand detailed data in weekly 
time buckets, by item and organization. Use this 
worksheet to manage and approve the forecast.
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Demand Analysis: Item and Zone Compare history and demand detailed data in weekly 
time buckets, by item and zone. Use this worksheet to 
manage and approve the forecast.

Waterfall Analysis Worksheet 

The first step in the Demand Management process is to look at your previous cycle and 
determine how accurate your forecasts were. Using the Waterfall Analysis worksheets 
you can compare actual versus forecast demand for individual product categories, 
organizations, and regions (zones). By comparing actuals to forecast, demand planners 
can identify problem areas, and deduce why forecast demand did better (or worse) than
planned.

For example, a retailer notices that some of their seasonal product categories did not 
perform well during December. Using this data, your demand analyst deduces that an 
unseasonably mild winter was to blame. Since this anomaly was restricted to December,
the demand analyst decides to not make any changes in future demand for those 
products. Based on the results in the Forecast Accuracy worksheet, demand analysts 
can make the required adjustments and take those lessons learned and apply them to 
the next forecast. 
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The Waterfall Analysis worksheet is aggregated to the following levels, which allows 
you to view and slice data depending on the details in which you're interested:

• Product Category and Zone

• Product Category and Organization

The following archived forecasts are used in these worksheets:

• 4 Week Lag Forecast: The forecast series for the four weeks prior to the current 
week. 

• 8 Week Lag Forecast: The forecast series for the eight weeks prior to the current 
week.

• 12 Week Lag Forecast: The forecast series for the 12 weeks prior to the current 
week. 

• 4, 8, and 12-Week Lag Absolute Percentage Error: A measure of forecast accuracy, 
which is calculated as actual demand minus forecast demand, and displayed as a 
percentage.

• 4, 8, and 12-Week Lag Absolute Deviation: A measure of forecast accuracy, and 
represents the average amount that the actual demand varies from forecast 
demand.

About the Forecast and Metrics View
The Forecast and Metrics view displays a table showing demand and forecast values for
individual products, broken down by weekly time buckets. 

About the Absolute Deviation View

The Absolute Deviation view graphically represents the amount of deviation that exists 
in your forecast at the four, eight and 13 week level, represented as total units. Use the 
Absolute Deviation view to determine how much real demand differs from the forecast.
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About the Forecast Percentage Error View

The Forecast Percentage view graphically represents the amount of deviation that exists
in your forecast at the four, eight and 13 week level, represented as a percentage of the 
demand. Use the Forecast Percentage view to determine how much real demand differs 
from the forecast.



4-6    Oracle Demantra Demand Management User's Guide

Reference
Basics:

Accessing this Worksheet Do one of the following:

1. In My Worksheets (in Collaborator Workbench), click 
either DM: Waterfall Analysis Product Category and Org 
or DM: Waterfall Analysis Product Category and Zone.

2. If a worksheet is currently open, click either DM: 
Waterfall Analysis Product Category and Org or DM: 
Waterfall Analysis Product Category and Zone and then 
click Open.

Levels you can select Either:

• Product Category and Zone

• Product Category and Organization
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Time Aggregation Weekly

Business Data:

Series Group Series Description

Forecast Accuracy 4 Week Lag 
Forecast

Forecast for the four weeks prior to the current 
time bucket.

8 Week Lag 
Forecast

Forecast for the eight weeks prior to the current 
time bucket.

13 Week Lag 
Forecast

Forecast for the 13 weeks prior to the current time 
bucket.

4 Week Lag 
Absolute Deviation

Absolute Deviation for the four weeks prior to the 
current time bucket.

4 Week Lag 
Absolute % Error

Absolute percentage error for the four weeks prior 
to the current time bucket.

4 Week Lag % 
Error

Percentage error for the four weeks prior to the 
current time bucket.

8 Week Lag % 
Error

Percentage error for the eight weeks prior to the 
current time bucket.

13 Week Lag % 
Error

Percentage error for the 13 weeks prior to the 
current time bucket.

8 Week Lag 
Absolute % Error

Absolute percentage error for the eight weeks prior
to the current time bucket.

8 Week Lag 
Absolute Deviation

Absolute Deviation for the eight weeks prior to the 
current time bucket.

13 Week Lag 
Absolute Deviation

Absolute Deviation for the 13 weeks prior to the 
current time bucket.

13 Week Lag 
Absolute % Error

Absolute percentage error for the 13 weeks prior to
the current time bucket.
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Historical Demand Demand Unconstrained demand. Purple if out of stock.

Sales Demand Unconstrained demand. Purple if out of stock.

Demand Analysis Worksheet 

Once you have reviewed your forecast from previous cycles to determine how accurate 
it was, the next step is to review the forecast for the current planning cycle. The 
Demand Analysis worksheets are available at the start of the planning cycle, and 
display historical data, forecasted demand accuracy statistics and demand priority at 
various levels of aggregation.

You can use the Demand Analysis worksheets to view, edit, and approve the forecast 
for individual weekly time buckets. The Demand Analysis worksheet is aggregated to 
the following levels, which allows you to view and slice data depending on the details 
in which you're interested:

• Product Category and Organization

• Product Category and Zone
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• Item and Organization

• Item and Zone

About the Demand Tracking Table
The Demand Tracking table compares sales and demand figures, at your chosen 
aggregation level, in weekly time buckets. It gives analysts a side-by-side view of their 
actual sales, demand and forecasted sales, along with Absolute Deviation and Absolute 
Percentage Error for comparison. 

This table tracks the following on a weekly basis:

• History

• History Override

• Adjusted History

• Baseline Forecast

• Simulation

• Base Override

• % Chg to Base

• Final Forecast

• Absolute Deviation

• Absolute Percentage Error

• Demand Priority

This table also enables users to track final approval for each line in the forecast. For 
more information, see Approving the Forecast, page 4-11.
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About the Demand Tracking Graph

The Demand Tracking graph displays the Sales, Demand, Sales Forecast, Simulation, 
and Final Forecast values for the chosen product category over time. 

About the Detail Demand Analysis Embedded Worksheet

The Detail Demand Analysis table is an embedded worksheet that compares sales and 
demand figures for your chosen aggregation level, in weekly time buckets. It gives 
analysts a side-by-side view of their historical sales, and forecasted sales, along with 
Absolute Deviation and Absolute Percentage Error for easy comparisons.

Use this worksheet to look at the item level detail for the category. Analysts often look 
at a higher level first and if the data is not what they expect, they drill down to lower 
levels to see the detail. As you click on different categories, the detail level worksheet 
reflects the items for the category, allowing you to review details for that particular 
item.

Modifying Sales Override Values
1. In My Worksheets (in Collaborator Workbench), click Demand Analysis. Or if a 

worksheet is currently open, click File > Open. Click Demand Analysis and then 
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click Open.

2. If the worksheet does not show data immediately, click Data > Rerun. Or click the 
Run button.

This launches the Demand Analysis worksheet.

3. Enters data in the History Override field for history or base override and/or the % 
Chg to Base field for the Forecast. 

The results are shown in the Adjusted History and Final Forecast columns.

Note: You can select and edit multiple cells.

4. From the Data menu, choose Save Data. Or click the Save Data button.

5. From the Data menu, choose Rerun.

The worksheet updates to display the edited values.

Setting the Demand Priority

Note: This setting is only applicable for Demantra integrations with 
EBS.

1. In My Worksheets (in Collaborator Workbench), click Demand Analysis. Or if a 
worksheet is currently open, click File > Open. Click Demand Analysis and then 
click Open.

2. If the worksheet does not show data immediately, click Data > Rerun. Or click the 
Run button.

This launches the DM: Demand Analysis worksheet.

3. In the Demand Priority field, double-click the cell for which you want to set a 
demand priority.

4. Enter the desired (numerical) priority. 

5. From the File menu, choose Save Worksheet.

Approving the Forecast

Approvers are notified in the My Tasks window that a new forecast is available for the 
current planning cycle. 

1. In My Tasks (in Collaborator Workbench), click Demand Analysis. Or if a 
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worksheet is currently open, click File > Open. Click Demand Analysis and then 
click Open.

2. If the worksheet does not show data immediately, click Data > Rerun. Or click the 
Run button.

This launches the Demand Analysis worksheet.

3. Do one of the following:

• To approve a line item in the forecast, click the appropriate check box in the 
Approve column. 

• To final approve a line item in the forecast, click the appropriate check box in 
the Final Approve column. 

4. From the File menu, choose Save Worksheet.

5. In My Tasks (in Collaborator Workbench), select the Demand Analysis worksheet 
and then click Done.

Demand Management notifies the final approver when all analysts have approved 
the current forecast.

Reference
Basics:

Accessing this Worksheet Do one of the following:

1. In My Worksheets (in Collaborator Workbench), click the
relevant worksheet.

2. If a worksheet is currently open, click File >Open. Click 
on the relevant worksheet.

Levels you can select One of:

• Product Category and Zone

• Product Category and Organization

• Item and Organization

• Item and Zone
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Time Aggregation Weekly unless Oracle Demantra was implemented with a 
monthly or daily time period.

Business Data:

Series Group Series Description

EBS Input Demand Priority The allocated demand priority (note that this series 
is only applicable for EBS integrations).

Forecast % Change to Base Factor override on sales forecast.

Base Override Manual override on sales forecast.

Final Forecast Final forecast (this appears in yellow if the 
difference between final forecast and final partner 
forecast does not meet the requirements of sales 
forecast tolerance).

Baseline Forecast Analytical sales forecast including user simulations.

Simulation Analytical re-forecast triggered by a user simulation.

Forecast Accuracy Abs Deviation Absolute deviation for the fit forecast.

Abs % Error Absolute percentage error for the fit forecast.

Final Approval When checked indicates that the forecast has 
received final approval. 

Final Approved By User who final approved the forecast.

Historical 
Demand

Adjusted History Shipment History – Request Date is the default.

History Historical actual sales/shipments. Shipment History 
– Request Date is the default.

History Override Manual override of historical actual sales/shipments.

Sales Adjusted History Unconstrained demand. Purple if out of stock.
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History Historical actual sales/shipments.

History Override Manual override of historical actual sales/shipments.

New Product Launch Management Worksheet
New Product Launch Management is the introduction of a new product at a site 
(DC/store), site group (also known as a store group), account, or retailer. Launch 
Management uses an existing product's historical demand to generate a forecast for the 
new product. With Launch Management you can: 

• Choose whether source data should be scaled when copied.

• Specify a start date when copying historical data.

• Specify an end date when copying forecast data.

• Specify how much historical demand to use (e.g. 50%, 100%, 200%, and so on).

You have the following options when launching a new product:

• New product introduction at one site based on an existing product.

• New product introduction at one, multiple or all accounts based on an existing 
product.

• New product introduction at one, multiple or all retailers based on an existing 
product.

• New product introduction at one, multiple or all site groups based on an existing 
product.

Launch Management can also copy promotional data including historical promotions 
from the source product.

Use the icons on the Launch Management toolbar to perform tasks in the Launch 
Management worksheets.

The New Product Launch Management worksheet uses the following series:

• Launch Type

• Launch Status

• Launch Status Detail

• Message
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Note: Review and/or update the NPI_SERIES_DATA table before 
creating any new product launch definitions. For more information,
see Configuring New Product Launches in the Oracle Demantra 
Implementation guide. 

Business Data
The following table provides information about the default series displayed in the 
worksheet:

Series Series Group Description

Copy Data Launch Management Indicates whether historical data will 
be copied to the new product. The 
following options are available:

• Yes - Copy source historical data 
to the new product. This is the 
default option.

For information about the 
columns copied from the source 
product to the target product, 
refer to Copy Data,

• No - Do not copy historical data. 
Only combinations specified from
the source population will be 
copied to the new product (the 
target).

Copy Percentage Launch Management Indicates the amount (as a percentage)
of historical data copied from the 
source item to the new product being 
introduced. The default value is 100, 
which means that all the historical 
data will be copied. Defining whether 
a specific series scales as part of data 
copy occurs when defining which 
series will be copied. If you only 
wanted to copy half of the historical 
data, you would enter 50 in this field.
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Launch Mode Launch Management Indicates when the new product 
request is processed. The following 
options can be displayed:

• Now - Initiates the new product 
introduction once the request is 
defined and saved. The Launch 
Management Realtime workflow 
runs continuously in the 
background and processes the 
request immediately when Now 
is selected.

• Batch - Initiates the new product 
request when the next Nightly 
Batch Process workflow runs.

Launch Status Launch Management Indicates the current status for the 
new product launch. 

For more information, see Launch 
Statuses.

Launch Status Detail Launch Management Provides additional explanation of the 
launch state. 

For more information, see Launch 
Status Details.

Launch Type Launch Management Indicates the type of launch requested 
- New Product Launch. In the New 
Product Launch Management 
worksheet, this Series displays New 
Product Launch since the worksheet is
dedicated to managing new product 
launches.

For more information refer to Launch 
Message Requests.

Message Launch Management Displays any validation or error 
messages for the launch request. 

For more information, refer to Launch 
Request Messages, page 4-21.

Product Launch Date Launch Management Indicates the date the new product is 
expected to be available.



Demand Management Worksheets    4-17

Request Date Launch Management Indicates the date the new product 
request was created.

Request ID Launch Management Indicates the internal processing ID 
assigned when the request was 
initiated.

User Name Launch Management Indicates the user that initiated the 
product launch request.

To Create a New Product Launch:
Use the New Product Launch Management worksheet to launch a new product at a 
store, store group or account. This worksheet is also used to view previous product 
launches. You can edit and cancel product launches that have not reached their product 
launch date, which is the date the product is expected to be available at the store. A 
similar worksheet is provided in the Demantra PTP and CDP components.

1. Click New Product Launch from the Launch Management toolbar, or right-click in 
the Members Browser and choose New Product Launch. The New Product Launch 
screen appears.

2. In the Request Name field, enter a descriptive name for the product launch.

3. Click the Edit button from the Source region. The Edit Source screen appears.

4. Define the source item and site, site group, or account levels to be used as the basis 
for the new product.

Note: New product introductions are only supported at the 
following levels:

• Item/DC Site

• Item/Site group (store Group)

• Item/Account

• Item/Retailer

One of these source-level combinations has to be selected for the new product 
introduction to be valid. Select the Item level. Select only one member for the Item 
and Site level. For the location level, select only one member from the Site, Account,
or Retailer level. If different levels or more than one member is selected, then the 
process will not execute successfully and the launch profile will not be added.
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1. Add Item to the Selected Filter Levels, and then add the source item to the 
Selected members.

Note: Only select a single item.

2. To add the new product to an account, add Account to the Selected Filter Levels
and add the account to Selected members.

3. Click Finish.

5. Accept the default dates for the source.

6. Click the Edit button from the Target region to define the target item for the new 
product. The Edit Target screen appears.

Note: The target Item must already exist. Demantra does not create 
the item. It must be available as a member of the Item level.

1. Select only a single item member. Add the item to the Selected Filter Levels, 
and then add the target item to the selected members.

2. Click Finish.

7. In the Product Launch Date field, enter the date the new product is expected to be 
available in the date format mm/dd/yyyy, or click the Product Launch Date list to 
select a date from the calendar.

8. From the Copy Data list, indicate whether the data from the source product should 
be copied to the new product.

Choose one of the following options: 

• Yes - Copy source historical data to the new product.

• No - Do not copy historical data to the new product. Only combinations 
specified from the source population will be copied to the new product (the 
target). The historical data from the combinations that were specified in the 
source section will not be copied to the target/new product, but the product will
be available at any of the locations that were specified as the source. The 
product will not have pseudo history on which to generate a forecast, but a 
forecast may be entered manually or imported from an external source.

• Yes (Include Promotion History) - Copy source historical promotions to the 
new product.
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Note: For newly created products only promotions occurring 
until the launch data will be copied. Past the launch date the 
Refresh Population process will be used to incorporate the new 
items into promotions.

9. In the Copy Percentage field, enter the percentage of the source item's historical 
data to be copied to the target item.

This value will be used to scale the information from the source item. If 200% is 
entered, then source item's historical demand is doubled when copied to the new 
item.

10. In the Copy Start Date – History field, enter the starting date to use when copying 
the source item's historical data to the target item.

11. In the Copy End Date – Forecast field, enter the end date to use when copying the 
source item's forecast data to the target item.

12. From the Launch Mode list, select one of the following options:

• Now - Used to initiate the new product introduction once the request is defined
and saved. The Launch Management Realtime workflow runs continuously in 
the background and processes the request immediately when Now is selected.

Note: If a product is added to a large number of stores, this 
process may take some time to complete.

• Batch - Used to initiate the new product request when the next Nightly Batch 
Process workflow runs. This option is recommended if the process will copy a 
very large amount of data, or if you are creating multiple product launches.

13. Click Submit. When prompted to create the population, click OK. 

If an error occurs, review the error message(s), modify the launch parameters as 
necessary, and then repeat the process.

Note: You may want to create a worksheet to review the new DM, 
PTP, or IMCDP data that was created by the New Product Launch 
process.

New Product Launch Workflows
These are the Demantra Predictive Trade Planning New Product Launch workflows:



4-20    Oracle Demantra Demand Management User's Guide

Workflow Name Purpose Description

Create Launch Management 
Views

Launch Management This workflow validates the 
NPI_SERIES_DATA 
definitions and should be run 
when the NPI_SERIES_DATA
table is modified. If all 
definitions in this table are 
valid, then the workflow 
modifies and refreshes the 
launch management 
integration interfaces. The 
Status column in 
NPI_SERIES_DATA will be 
set to either Valid or Invalid. 
If the status is set to Invalid, 
then the ERROR_MESSAGE 
column will be populated 
with the appropriate error 
message.

Launch Management Batch Launch Management Executed by the Nightly 
Batch Process workflow to 
process launch requests with 
Status of Valid and Launch 
Mode of Batch. 

Launch Management 
Ongoing

Launch Management Executed by the Weekly Batch
Process workflow to process 
product and store launch 
requests with Status of 
Processed and Ongoing. If the
new product or store launch 
date is greater than or equal 
to "max_sales_date" system 
parameter, then it sets the 
Launch Status to Completed. 

Launch Management 
Realtime

Launch Management Runs continuously in 
background to process launch
requests with Status of Valid 
and Launch Mode of Now. 
This workflow is scheduled to
Launch on Startup. It runs 
whenever the Demantra Web 
application is restarted.
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Launch Request Messages
The Messages field displays any validation or error messages for the launch request. 
The table below provides a description of the launch messages that can be displayed for
a request. If the message indicates your launch request was unable to be processed, 
modify the launch parameters as necessary, and then resubmit the request.

Launch Message Description

(Empty) If the Message field is empty, then no errors occurred 
while processing the launch request.

Multiple Source Account Selection is 
Not Allowed

Displayed when multiple level members selected for 
the "Account" level in the source population attribute 
for the New Product Launch request.

Ongoing Launch Request already 
exists for the Target Item. Edit the 
Original Launch Request.

Displayed when a launch request already exists for the
given target new product and site/site 
group/account/retailer

Validation Success The source and target population selections were 
successfully validated.

Multiple Source Item Selection is Not 
Allowed

During a new product launch request, multiple level 
members were selected for the " Item" level in the 
source population attribute.

Multiple Target Item Selection is Not 
Allowed

During a new product launch request, multiple level 
members selected for the "Item" level in the target 
population attribute.

Same Item Cannot be selected for 
both Source and Target

During a new product launch request, the same level 
member was selected for the "Item Level" in both the 
source and target population attribute.

Source/Target Item Selection is 
Missing

During a new product launch request, a level member 
was not selected for the "Item" level in the source or 
target population attribute.

Configure to Order Worksheets
Predefined Worksheets

Worksheets with the necessary series for analysis and modification of the forecast and 
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historical data will be available for the planner at the beginning of each cycle. These are 
the same worksheets available in Oracle Demantra Demand Management. For each set, 
there are four predefined high level worksheets and one base level worksheet that is 
launched from the high level worksheet. The worksheets are:

• Waterfall Analysis: Product Category and Organization

• Waterfall Analysis: Product Category and Zone

• Demand Analysis: Product Category & Org

• Demand Analysis: Product Category & Zone

• Demand Analysis: Item and Org

• Demand Analysis: Item and Zone

Worksheets for Demand by Base Model, Option, and Item

There are configure to order seeded worksheets for the review of the bill of material 
dependent demand. The purpose of these worksheets is to support the demand 
planning process by analyzing the dependent demand for all the options and items that 
belong to a base model. This analysis can be accomplished either across all the location 
dimensions such as organization and site or for a specific organization and site. Some 
worksheets display the information an indented bill of material layout. 

This table shows information about worksheet CTO: Item Demand by BOM by Week 
(Crosstab). This worksheet is similar to worksheet CTO: Item Demand by BOM by 
Month (Crosstab). However, it is at the week time level.

Selected series:

• Adjusted History

• Consensus Forecast

• Forecast Dependent Demand

•  Forecast Dependent Demand Override

• Final Forecast Dependent Demand

• Consensus Total Demand

• Final Plng Pct

• Plng Pct Choice

• Plng Pct Override

Worksheets for Demand Forecast for All Items of an Option and Base Model
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These seeded worksheets are for the dependent demand review of all the items for an 
option-model combination. The purpose of these worksheets is to support the demand 
planning process by analyzing the dependent demand for all the dependent items for 
an option and base model. This analysis can be accomplished either across all the 
location dimensions such as organization and site or for a specific organization and site.
There are two seeded worksheets--one across all the organizations and sites and the 
other by organization and site. If the worksheet display is across all organizations, Final
Planning Percentage is not in the display.

This table shows information about worksheet CTO: Demand for All Items of an Option
& Base Model. This worksheet is similar to worksheet CTO: Demand for All Items of an 
Option & Base Mode across Org and Site. However, it does not have Organization and 
Site selected for Levels in the page section and does not display Final Planning 
Percentage.

Selected series: 

• Adjusted History

• Consensus Forecast

• Forecast Dependent Demand

• Forecast Dependent Demand Override

• Final Forecast Dependent Demand

• Consensus Total Demand

Worksheet CTO: Demand for All Items of an Option & Base Model across Org and Site 
is similar to worksheet CTO: Demand for All Items of an Option & Base Model. 
However, this worksheet has Organization and Site selected for Levels in the page 
section.

Worksheets for Total Demand and Amount by Option Across All Models

These seeded worksheets are for the review of option demand across all base models. 
The purpose of these worksheets is to support the demand planning process by 
analyzing the demand generated for the options across base models. This analysis can 
be accomplished either across all the location dimensions such as organization and site 
or for a specific organization and site. There are two seeded worksheets--one across all 
the organizations and sites and another by organization and site.

This table shows information about worksheet CTO: Total Demand & Amount by 
Option Across All Models. This worksheet is similar to worksheet CTO: Total Demand 
& Amount for Options by Base Model. However, it does not include Base Models in the 
display.

Selected series: 

• Adjusted History
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• Consensus Forecast

• Final Forecast Dependent Demand

• Consensus Total Demand

• Consensus Forecast Amount

• Final Forecast Dependent Demand Amount

• Consensus Total Demand Amount

Worksheet CTO: Total Demand & Amount for Options by Base Model is similar to 
worksheet CTO: Total Demand & Amount by Option Across All Models. However, this 
worksheet displays the Base Models.

Worksheets for Total Demand and Amount by Item and Week

Worksheet CTO: Total Demand and Amount by Item and Week is for the review of 
demand and mount for all items, base models and options. The purpose of these 
worksheets is to support the demand planning process by analyzing the total demand 
generated for an item or component.

Selected series: 

• Adjusted History

• Final Forecast Dependent Demand

• Consensus Forecast

• Consensus Total Demand

• Final Forecast Dependent Demand Amount

• Consensus Forecast Amount

• Consensus Total Demand Amount

Filtering Data on CTO Worksheets
By default, CTO worksheets are filtered to only display items with CTO data. This 
includes items that are CTO-only, as well as items with both CTO and sales data. CTO 
worksheets can be configured to also display general sales data through the Advanced 
Worksheets Options dialog box. 

To see the Advanced Worksheet Options dialog box, go to Worksheet Designer, 
navigate to section Aggregation, and click button Advanced. You can click button 
Advanced if either:
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• The worksheet includes a series that is based on a general level

• You select a general level as an aggregation level or filter

These are the settings:

• Include SALES_DATA combinations only: The worksheet displays all of the 
combinations that have historical demand (that exist in table SALES_DATA).

• Include CTO combinations only: The worksheet displays only combinations that 
have historical demand for the specified base models.

• Both options: The worksheet displays all combinations that have historical demand.
This includes combinations with independent demand from Sales_data and 
combinations with dependent demand such as CTO data.

• Neither option: If neither option is checked, only items that are in Sales_data and 
CTO data are displayed. For example, base models and items with both 
independent and dependent demand.

• All General Levels: Available only when you select neither of the other options. The
Neither option displays but uses the lowest level of aggregation for the specified 
members as criteria for displaying combinations

Caution: Overriding the Base Override series for the Option and 
Option Classes series may cause unexpected results when viewing 
worksheet data and creates extraneous combinations in the 
SALES_DATA table. To prevent this, Oracle strongly recommends 
adding an Edit-Lock expression to the Base Override series and any 
other SALES_DATA series that are not relevant to Options and Option 
Classes.

For more information, see Creating an Edit-Lock Expression in the 
Oracle Demantra Implementation Guide.

Service Parts Forecasting (SPF) Worksheets
The following Demantra Service Parts Forecasting worksheets are available:

• SPF: Analyze Forecast Organization Latest Revision

• SPF: Analyze Forecast Latest Revision

• SPF: Analyze Organization Base Model Spare
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SPF: Analyze Forecast Organization Latest Revision Worksheet
Use this worksheet to review and modify the forecast for a specific Latest 
Revision/Organization. You can view the inputs used for both forecasting methods 
(statistical and calculated) and review both the forecasts and MAPE values for each.

You can then modify the historical demand and analytical settings and run simulations. 
Reject a simulation to roll back the changes and start over. Accept a simulation if you 
prefer the results over the original values.

You can also toggle between different forecast methods or override the forecast 
manually. The series SPF Final Forecast displays results of any changes.

The SPF: Analyze Forecast Organization Latest Revision worksheet uses the following 
series:

• SPF Item Usage

• SPF Item Usage Override

• SPF Item Usage Final

• SPF Baseline Forecast

• SPF Simulation

• SPF Calculated Forecast

• SPF Forecast Method

• SPF Forecast Override

• SPF Final Forecast

• SPF Failure Rate % Final

• SPF Forecast MAPE (Out of Sample)

• SPF Calculated Forecast MAPE

• SPF Average Demand

For details about these series, see Service Parts Forecasting Series, page A-17. 

SPF: Analyze Forecast Latest Revision Worksheet
This worksheet provides an aggregated view of item usage, statistical and calculated 
forecasts, and accuracy metrics for a Latest Revision consisting of one or more spares 
across all organizations. You can easily modify the worksheet to display specific spares, 
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organizations, or tiers. When more detailed analysis of Latest Revision is necessary, use 
the SPF: Analyze Forecast Spare/Organizations worksheet.

This worksheet does not provide the SPF Forecast Override series by default, but you 
can add it if desired.

The SPF: Analyze Forecast Latest Revision worksheet includes the following series:

• SPF Item Usage Final

• SPF Baseline Forecast

• SPF Simulation

• SPF Calculated Forecast

• SPF Forecast Method

• SPF Forecast Override

• SPF Final Forecast

• SPF Forecast MAPE (Out of Sample)

• SPF Analytical Forecast MAPE

• SPF Calculated Forecast MAPE

• SPF Analytical Forecast BIAS %

• SPF Calculated Forecast BIAS %

• SPF Final Forecast MAPE 1 Month Lag

For details about these series, see Service Parts Forecasting Series, page A-17. 

SPF: Analyze Organization Base Model Spare Worksheet
This worksheet displays the Base Model, Spare, and the Latest Revisions servicing the 
Base Model at the Organization level. This view allows you to carefully examine 
historical install base and the projected install base. In this view you can override or 
simulate changes to install base and see how it will affect the forecast across spares that 
are associated with the base model.

The worksheet uses the BOM tree with Base Model displayed followed by all spares 
that are part of the base model. Modifications which result in changes of values shown 
in the SPF Install Base Final or SPF Failure Rate % Final series are propagated to the SPF
Calculated Forecast series.

The SPF: Analyze Organization Base Model Spare worksheet includes the following 
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series:

• SPF Latest Rev

• SPF Install Base under Contract

• SPF Install Base Forecast

• SPF Install Base Simulation

• SPF Install Base Override

• SPF Install Base Final

• SPF Item Usage

• SPF Item Usage Override

• SPF Item Usage Final

• SPF Engineering Estimated Failure Rate %

• SPF Failure Rate % Calculated

• SPF Failure Rate % Generation Method

• SPF Failure Rate % Override

• SPF Failure Rate % Final

• SPF Calculated Forecast

• SPF Baseline Forecast

• SPF Forecast Method

• SPF Forecast Override

• SPF Final Forecast

For details about these series, see Service Parts Forecasting Series, page A-17. 
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5
Configuring Demand Management

Important: The Demantra Local Application replaces Collaborator 
Workbench. You may see both names in this text.

This chapter covers the following topics:

• Overview of the Configuration Process

• Configuring Demand Management Users

• Configuring Approval Workflows

• Configuring the Base Time Unit and Time Bucket Start Day

• Configuring the Item Short Name and Description

• Controlling System and Engine Maximum Sales Dates

• Purging Historical Sales Data

Overview of the Configuration Process
Demand Management works with supply chain planning data from external systems. 
Ultimately, those systems own most of the data; and Demand Management is 
responsible only for producing unconstrained forecasts for future demand and for 
generating tactical, operational, and strategic business plans.

Demand Management is designed for minimum amount of configuration, and comes 
with pre-seeded worksheets, users and groups, and workflows. To configure Demand 
Management, the general steps are as follows:

1. Demand Management utilizes users and user groups to facilitate the forecast review
process. Pre-seeded users are provided in the Business Modeler. The Administrator 
should modify these users to reflect the names of the analysts, forecast approver 
and administrator. Forecasts from each analyst require approval from the final 
approver.
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In deployments using multiple lines of business, the Administrator should also 
assign product lines, families, and so on to analysts using Demantra User Security 
settings in the Demantra Business Modeler. 

For more information, see Configuring Demand Management Users, page 5-2.

2. Demand Management uses the Archive Forecast, Demand Forecast, and Planning 
Group workflows to facilitate approval process. These workflows must be 
configured to include the user names of your Demand Analysts, Demand Manager, 
and Demand Administrators. 

For more information, see Configuring Approval Workflows, page 5-5.

3. By default, Demand Management uses a weekly base time resolution with a 4-4-5 
weekly fiscal calendar hierarchy. This time resolution is fully configurable and may 
be changed to either days or months. As well, you can configure forecast start day, 
which is set to Monday by default. 

For more information, see Configuring the Base Time Unit and Time Bucket Start 
Day, page 5-13.

4. You can optionally configure the Demand Management worksheets to display item 
short names and descriptions.

For more information, see Configuring the Item Short Name and Description, page 
5-17.

5. You can configure how Demantra handles future data using the MaxSalesGen 
parameter. This parameter determines how data after the end of history is 
populated. Demand Management uses a configurable MaxSalesGen parameter to 
control how the EP_LOAD process loads future data. 

For more information, see Controlling System and Engine Maximum Sales Dates, 
page 5-18.

6. Demand Management uses automated workflows to import sales and other 
referenced data from external corporate systems. These workflows provide 
integration to external systems such as Oracle EnterpriseOne and EBusiness Suite. 
The actual workflows used depend on your ERP system configuration, and must be
modified. As well, you may be required to make certain changes within your ERP 
environment.

Configuring Demand Management Users
During installation, Demand Management adds pre-seeded users and user groups that 
are required by the application and used for the approval process. During the 
configuration process, administrators should modify these users and groups to reflect 
the analysts and approvers who will be performing approval tasks. The Administrator 
also edits a pre-seeded Planning Group Workflow to specify the ID of the Final 
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Approver who will be notified when the Analysts forecasts are ready for review. For 
more information on modifying user details, see Creating or Modifying a User in the 
Oracle Demantra Implementation Guide.

Demand Management adds the users Analyst 1-5, to the system; these users belong to 
the new user group Demand Analyst. Admin1 and Manager1 are also added. These 
users are used within the Demand Management workflows. For more information on 
configuring these workflows, see Configuring Approval Workflows, page 5-5.

Filtering User Data

Note: Predefined users come with the ability to see all the data loaded 
into the system. If there is a requirement to limit this, a data filter can be
applied to the users. For more information on filtering user data, see "
Creating or Modifying a User" in the Oracle Demantra Implementation 
Guide. 

1. Log on to the Business Modeler.

2. From the Security menu, choose Create/Modify User.

The Create/Modify User dialog box appears.

3. Double-click the user icon for which you want to filter user data.

4. The User wizard appears.
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5. Click the Next button until the Select User Filters dialog box appears. This dialog 
box lets you filter the data that the user can see; specifically, you control which 
levels and members the user can see.

6. Filter the data that the user can see, as follows:

• Click a level in the left side of the dialog box and drag it to the box on the right. 
Or double-click a level in the left side.

• Now specify which members of this level the user can see. To do so, click a 
member in the list, and then click the right arrow button. Or double-click the 
member you want to filter out.

The system moves the selected members to the box on the lower right side.
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7. Repeat the preceding steps for each filter you want to add. Each filter automatically 
limits the choices available in subsequent filters.

8. When you have appropriately filtered data for the user, click Finish.

Configuring Approval Workflows
Oracle Demand Management uses the Archive Forecast, Demand Forecast and 
Planning Group workflows to automate the approval process. These workflows are 
pre-seeded to manage batch forecasting and facilitate the forecast approval process. 

The workflows should be scheduled to run regularly by the Administrator. Specifically, 
the workflows:

• Reset the Final Approval and Final Approve By series to null.

• Run the Analytical Engine to generate a statistical forecast.

• Notifies all users in the Demand Analyst group that the forecast is available.

• Notifies the Manager (the final approver), when all analysts have approved the 
forecast or when the process has exceeded an allotted time.

• Periodically rolls forecast data, based on engine profiles that are configured and 
activated in the Business Modeler.

Although these workflows do not generally require customization, the Administrator 
must ensure the Demand Analyst group contains the user names of the users who 
modify the forecast and the Manager1 and Admin1 users have also been specified.



5-6    Oracle Demantra Demand Management User's Guide

Note: Before configuring your approval workflows, you should 
configure the users you plan to use for approvals. 

Configuring the Demand Forecast Workflow

The Demand Forecast workflow runs when the EP_LOAD process has completed, and 
resets the forecast approval status, generates a new forecast, and initiates the approval 
process.

1. Log into the Workflow Manager.

2. Locate the Demand Forecast workflow, and click the corresponding Edit button. 

The Edit Schema window opens, showing the Demand Forecast definition.

3. Double-click the NotifyForecastFinalApproved user step.

The User Step's Properties dialog box appears.
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4. In the User drop-down list box, choose the Demand Management Administrator 
account that you want to notify when the forecast has been approved. The default is
Admin1.

5. Click OK. 

6. In the Workflow Editor, click the Save button.

Configuring the Planning Group Workflow

The Planning Group workflow is responsible for sending notifications to Demand 
Analysts and Demand Managers when forecasts have been approved or a set time-out 
condition is met.

1. Log into the Workflow Manager.

2. Locate the Planning Group workflow, and click the corresponding Edit button. 

The Edit Schema window opens, showing the Planning Group definition.
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3. Double-click the NotifyForecastComplete group step.

The User Step's Properties dialog box appears.
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4. Do one of the following:

• From the Users list, select the users that you want to notify when the forecast is 
generated. To select more than one user, press and hold the Ctrl key while 
clicking users.

• From the Groups list, select the user group that you want to notify when the 
forecast is generated. To select more than one user, press and hold the Ctrl key 
while clicking groups.

5. Click the Time tab.

6. The Group Step's Properties dialog box appears.
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7. In the Manager field, specify the user to notify if analysts' reviews are not 
completed on time. The default user is Manager1.

By default, the workflow's timeout is set to five days and the alert is set to four 
days. Depending on your planning cycle, you may want to increase or decrease this 
value. 

8. In the Timer section, enter a value (in days) at which point the workflow expires. 
When this time is reached, the user specified in the 
NotifyForecastAnalysisNotComplete step is initiated and the manager is notified 
that some of the Analysts have not reviewed their forecasts.

9. In the Alert Time section, enter a value (in days) at which point the workflow 
should send a reminder. 

10. Click OK.
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11. Double-click the NotifyForecastAnalysisComplete User Step.

The User Step's Properties dialog box appears.

12. In the User drop-down list box, choose the user that you want to notify when all 
approvals are completed; the default is Manager1.

13. Click OK.

14. Double-click the NotifyForecastAnalysisNotComplete User step.

The User Step's Properties dialog box appears.

15. In the User drop-down list box, choose the user that is to be notified that the 
Analysts' reviews are complete before the specified timeout. The default value is 
Manager1.

16. Click OK.

17. In the Workflow Editor, click the Save button.
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Configuring the Approve Forecast Workflow
The Approve Forecast workflow rolls forecast data, based on the engine profiles 
configured and activated in the Business Modeler. 

1. Log in to the Workflow Manager.

2. Locate the Approve Forecast workflow, and click the corresponding Edit button. 

The Edit Schema window opens, showing the Approve Forecast definition.

3. Double-click the User step.

4. In the User drop-down list box, enter the user name for the Demand Administrator 
that you want to notify when the forecast is rolled; the default is Admin1.

5. Click OK.

6. In the Workflow Editor, click the Save button.

Configuring Approval Workflows for Multiple User Groups

If there is more than one group of Analysts and Managers (Final Approver) that review 
and modify the forecast, then the Administrator must change the pre-seeded workflows
to handle the additional groups. Specifically, you must:

1. Duplicate Planning Group workflow with the following modifications for each 
additional group:

1. Log in to the Workflow Manager.

2. Edit the Planning Group workflow.

3. In the Planning Group workflow's Group Step dialog box, add the additional 
group and users that are part of the approval process.

4. Click the Time tab.

5. Check the Manager check box and select the Manager's ID from the list of 
values.

6. Modify Timeout settings, if required.

7. Click OK.

2. Modify the Demand Forecast workflow to add additional ApproveForecast steps:

1. Log in the Workflow Manager.
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2. Edit the Demand Forecast workflow.

3. Double click the Custom Step icon to add an additional custom step.

4. In the Class Name field, enter the class name. This should be the same as in the 
original step. (For example, 
com.demantra.workflow.step.WorkflowLauncherStep).

5. In the Parameters section, click Add.

6. Add the schema_id parameter, and assign it the same value as the schema_id 
parameter in the duplicate Planning Group workflow created in step 1.

7. Add the user_id parameter, and assign it the same value as the user_id 
parameter in the duplicate Planning Group workflow created in step 1.

8. Add the sync parameter, and assign it the same value as the sync parameter in 
the duplicate Planning Group workflow created in step 1.

9. Click OK.

Configuring the Base Time Unit and Time Bucket Start Day
The default Demand Management time hierarchy is a 4-4-5 (week) fiscal calendar. You 
can change this configuration to suit your business needs. If you change the base time 
unit from Week to either Day or Month, then all worksheets and integration profiles 
need to be re-configured. The data model must be upgraded for the changes to take 
effect.

The base time bucket start day is Mondays by default, with the week ending Sunday. 
The Demand Administrator may change this base time unit after initial installation 
using the Business Modeler's Data Model wizard. 

Note: This change will affect all users in the system and should be 
coordinated through the Demantra system administrator. In addition, 
changing this setting will clear all time dependant information in the 
system and require a full historical refresh.

If the time bucket is changed from weekly to either daily or monthly, then the 
corresponding series has to be created for the lagged forecast series used in the 
Waterfall Analysis worksheets. For example, it may no longer be appropriate to use the 
last 13 lagged forecast cycles as a base for the worksheet. 

Changing the Base Time Unit and Time Bucket Start Day
1. Log into the Business Modeler. If you do not have access to this, contact your 
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Demantra system administrator.

2. From the Data Model menu, choose Open Data Model. 

The Open Existing Data Model/Template dialog appears

3. Double-click the Demand Management model icon.

The Data Wizard appears.

4. Click the Next button twice.

The Select Time Bucket dialog box appears.
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5. In the Time Bucket field, choose the level at which you want your time buckets.

6. In the First Day of Week field, choose the day of the week on which you want to 
start the time bucket.

7. Click the Next button until you reach the Finish Wizard dialog box.

8. Click the Build Model button.

The Build/Upgrade Model dialog box appears.
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9. Now you can select whether to completely replace the existing data model or just 
modify it:

• If you want to completely replace the existing data model, choose Build New 
Model and select one of the, following options:

• Replace Series: Click this to completely replace the existing series 
definitions.

• Keep Series: Click this if you do not want to make any changes to the 
existing series. This option is suitable if you are in the process of working 
on the data model but do not want to spend the time updating the series 
definitions right now.

Note: This option will delete all worksheets, integrations 
and other aspects of the Demand Management application.

• Alternatively, if you are just modifying an existing data model, select Upgrade 
Existing Model. In this case, if you have made changes to the base time unit, 
select Run Time Bucket.

10. Click OK.

The process of building the data model begins. This may take a few minutes.



Configuring Demand Management    5-17

• Demantra highly recommends upgrading an existing model, rather
than building a new model. For more information, see Building the 
Data Model in the Oracle Demantra Implementation Guide.

• You will need to redefine integration profiles and worksheets if the 
time levels specified therein are now invalid.

Configuring the Item Short Name and Description
Use the following procedure to configure your worksheets to display item short names 
(for example, AS63311) and descriptions (for example, Vision Pad Gold Item 1). 

1. Log on to the Collaborator Workbench.

2. In My Tasks, click the worksheet to which you want to add item short names and 
descriptions.

Or if a worksheet is currently open, click File > Open. Click the worksheet to which 
you want to add item short names and descriptions, and then click Open.

3. From the Worksheets menu, choose Layout Designer.

The Worksheet Designer appears.

4. Click the Aggregation button.
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5. Do one or more of the following to add item short names and descriptions to the 
worksheet:

• To display the item short name, select Item.

• To display the item description, select Item Description.

6. Click the Filters button.

7. Do one or more of the following to add item short names and descriptions to the 
worksheet:

• To display the item short name, select Item.

• To display the item description, select Item Description.

8. Click OK.

9. From the Data menu, choose Rerun.

Controlling System and Engine Maximum Sales Dates
Traditionally, only historical information was loaded into Demantra using the 
EP_LOAD process. All future information (that is, forecast data) is loaded using 
integration profiles or other loading mechanisms. This mechanism controlled the dates 
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marked as end of history for the Forecasting Engine and the Collaborator Workbench.

With the addition of the MaxSalesGen parameter, you can now use the EP_LOAD 
process to load future dates into Demantra. This parameter determines how data after 
the end of history is populated.

Note: When populating the MaxSalesGen parameter, its important to 
enter all dates in the MM-DD-YYYY 00:00:00 format.

Populating the MaxSalesGen Parameter
1. Log into the Demantra Business Modeler.

2. From the Parameters menu, choose System Parameters.

The System Parameters dialog box appears.

3. Click the System tab.

4. In the MaxSalesGen field, enter one of the following values:

• Null: If you leave this parameter blank, Demantra compares the last date 
loaded into the system to the current last system date. The latest of the two 
dates is set to the last date of history.

Use this setting when only historical dates are being loaded.

• Sysdate: Use this value to base the last date of history on the period containing 
today's date. For example, in a weekly system with weeks beginning Monday, if
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run on Feb 16th 2007 the last date of history would be set to the previous 
Monday 2/12/2007. For a monthly system run on the same date the end of 
history would be set to 2/1/2007.

Use this value where the system date should match current date while allowing
future information to be loaded.

• 01-01-1900 00:00:00: Use this date to set the end of history to the last date in the 
sales_data table where the actual_quantity column>0.

Use this value in production environments where future information is being 
loaded but there is a lag in historical information availability. It is critical that 
the data used to drive the engine be stored in the actual_quantity column. Note 
that using this setting can potentially increase loading times for large 
deployments.

• Any date other than 01-01-1900 00:00:00: Any other date will cause the last date
of history to be based on the entered date. In a weekly system with weeks 
beginning Monday, if date entered is Jan 16th 2007 the last date of history 
would be set to the previous Monday 1/15/2007. For a monthly system run with
the same parameter setting the end of history would be set to 1/1/2007.

Use this value to test systems where the desired end of history date does not 
match executed date. Allows users full control on dates assigned as end of 
history and beginning of forecast.

5. Click the Save button.

Purging Historical Sales Data
When purging historical sales data, Demantra uses the following operators to select 
date ranges: 

• For Date From, Demantra selects the first available date that is greater than or equal
to (>=) the specified Date From value.

• For Date To, Demantra selects the last available date that is less than or equal (<=) to
the specified Date To value. 

Note: When choosing date ranges to purge, the collection date range 
should align with the time unit start date. 
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A
Demand Management Levels and Series

Important: The Demantra Local Application replaces Collaborator 
Workbench. You may see both names in this text.

This appendix covers the following topics:

• Demand Management Levels

• Demand Management Series

Demand Management Levels
The following is a list of the available levels in the Demand Management application:

Available E-Business Suite Levels
For Item dimensions:

• Asset Group

• Asset Group Attribute 1

• Asset Group Attribute 2

• Asset Group Attribute 3

• Class Code

• Demand Class 

• Item

• Item Description

• Item Type 
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• Product Category 

• Product Family

• Master Item

For Location dimensions:

• Organization

• Legal Entity 

• Operation Unit 

• Business Group 

• Sales Channel 

• Site 

• Account 

• Customer 

• Customer Class 

• Trading Partner Zone 

• Zone 

Available EnterpriseOne Levels
For Item dimensions:

• Item 

• Item Category Code 1

• Item Category Code 2

• Item Category Code 3

• Item Category Code 4

• Item Category Code 5

• Item Category Code 6

• Item Category Code 7
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• Product Description 

For Location dimensions:

• Organization

• Item Category Code 1

• Item Category Code 2

• Item Category Code 3

• Item Category Code 4

• Item Category Code 5

• Branch City

• Branch Country 

• Branch State 

• Site 

• Account 

• Customer Category Code 1

• Customer Category Code 2

• Customer Category Code 3

• Customer Category Code 4

• Customer Category Code 5

• Customer Category Code 6

• Customer Category Code 7

• Customer City 

• Customer Country 

• Customer State 

• Trading Partner Zone 
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Available Configure to Order Levels

Level Level Type Parent Level Data Table Population 
Attribute

Description

CTO General Level T_EP_CTO t_ep_cto Contains 
information 
for each link 
in the BOM 
tree.

Parent Item General Level T_EP_CTO_P
ARENT_ITE
M Synonym 
to 
T_EP_ITEM

- Alias level to 
Item, contains
the parent 
items in the 
BOM tree.

Base Model - T_EP_CTO_B
ASE_MODEL

- Contains the 
Base Model 
items in the 
BOM tree.

Demand 
Type

- T_EP_CTO_D
EMAND_TY
PE

- Identifies 
whether a 
link is a Base 
Model or an 
Option. 

Available Service Parts Forecasting Levels
For information about SPF Item levels, refer to the Available EBS Levels, page A-1.

SPF Location levels:

• Organization Type 

• Organization Tier 

• Country Virtual

• Region Virtual

•  Time Zone Virtual 

• Global Virtual
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SPF General Levels
The table below provides information about general SPF levels.

Level Level Type Parent Level Data Table Population 
Attribute

Description

SPF General Level SPF Base 
Model

T_EP_SPF t_ep_spf Contains 
information 
about each 
item in the 
service BOM 
tree.

SPF Base 
Model

General Level - T_EP_SPF_B
ASE_MODEL

- Contains 
information 
about the 
Base Model 
(root item) of 
the service 
BOM.

SPF Child General Level - T_EP_SPF_C
HILD_ID

- Internal level 
used to map 
BOM 
structure.

SPF Demand 
Type

General Level - T_EP_SPF_D
EMAND_TY
PE

- Level 
indicating 
whether 
selected 
member 
stores 
dependant or 
independent 
demand.
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Level Level Type Parent Level Data Table Population 
Attribute

Description

SPF Latest 
Revision

General Level - T_EP_SPF_L
ATEST_REV

- Level that 
groups 
different 
spares in the 
same 
supersession. 
Level can be 
used for 
forecasting 
items serving 
the same role 
for a base 
model 
together.

SPF Parent General Level - T_EP_SPF_P
ARENT

- Internal level 
used to map 
BOM 
structure.

SPF Parent 
Item 

General Level - T_EP_SPF_P
ARENT_ITE
M

- Internal level 
used to map 
BOM 
structure.

General Levels that Support Asset Intensive Planning Integrations
The levels SPF Maintenance Type, SPF Visit Stage Type, SPF Visit Type and SPF Transit 
Visit will be disabled by default in the DM and S&OP components. 

For more information about this integration, refer to "Oracle Demantra Integration with 
Asset Intensive Planning Applications" in the Oracle Demantra Implementation Guide. 
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Level Level Type Parent Level Data Table Population 
Attribute

Description

SPF Visit 
Stage Type

General Level - t_ep_spf_visit
_stage_type

- Type of visit 
stage a 
specific 
maintenance 
work order is 
associated 
with. Used to 
stripe work 
order usage. 

This level is 
provided to 
support 
Demantra 
integration 
with Oracle 
Complex 
Maintenance 
Repair and 
Overhaul 
(cMRO) 
and/or 
Enterprise 
Asset 
Management 
(eAM). 
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Level Level Type Parent Level Data Table Population 
Attribute

Description

SPF Visit 
Type

General Level SPF Transit 
Visit

t_ep_spf_visit
_type

- Type of visit 
a specific 
maintenance 
work order is 
associated 
with. Used to 
stripe work 
order usage. 

This level is 
provided to 
support 
Demantra 
integration 
with Oracle 
Complex 
Maintenance 
Repair and 
Overhaul 
(cMRO) 
and/or 
Enterprise 
Asset 
Management 
(eAM). 
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Level Level Type Parent Level Data Table Population 
Attribute

Description

SPF Transit 
Visit

General Level - t_ep_spf_tran
sit_visit

- Parent of SPF 
Visit Type 
used to 
specify 
whether 
specific visit 
type is 
associated 
with 
scheduled 
maintenance 
or with a 
transit visit. 

This level is 
provided to 
support 
Demantra 
integration 
with Oracle 
Complex 
Maintenance 
Repair and 
Overhaul 
(cMRO) 
and/or 
Enterprise 
Asset 
Management 
(eAM). 
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Level Level Type Parent Level Data Table Population 
Attribute

Description

SPF 
Maintenance 
Type

General Level - t_ep_spf_mai
nt_type

- Type of 
maintenance 
to which the 
work order is 
associated. 
Used to stripe
work order 
usage. 

This level is 
provided to 
support 
Demantra 
integration 
with Oracle 
Complex 
Maintenance 
Repair and 
Overhaul 
(cMRO) 
and/or 
Enterprise 
Asset 
Management 
(eAM). 

Demand Management Series
The following is a list of series used by the Demand Management application:

Series Description

% Change to Base Factor Override on Sales Forecast

1 Week Lag Forecast Forecast as of 1 Week ago.

10 Week Lag Forecast Forecast as of 10 Weeks ago.

11 Week Lag Forecast Forecast as of 11 Weeks ago

12 Week Lag Forecast Forecast as of 12 Weeks ago
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Series Description

13 Week Lag Absolute 
Dev

Absolute Deviation of 13 Week Lagged Forecast

 (abs(13 Week Lag Forecast - Adjusted History)) 

13 Week Lag Absolute 
Pct Err

Absolute Pct Error of 13 Week Lagged Forecast 

(abs(13 Week Lag Forecast - Adjusted History)/ Adjusted History) 

13 Week Lag Forecast Forecast as of 13 Weeks ago

13 Week Lag Pct Err Pct Error of 13 Week Lagged Forecast 

((13 Week Lag Forecast - Adjusted History)/Adjusted History) 

2 Week Lag Forecast Forecast as of 2 Weeks ago

3 Week Lag Forecast Forecast as of 3 Weeks ago

4 Week Lag Absolute 
Dev

Absolute Deviation of 4 Week Lagged Forecast 

(abs(4 Week Lag Forecast - Adjusted History)) 

4 Week Lag Absolute 
Pct Err

Absolute Pct Error of 4 Week Lagged Forecast 

(abs(4 Week Lag Forecast - Adjusted History)/ Adjusted History) 

4 Week Lag Forecast Forecast as of 4 Weeks ago

4 Week Lag Pct Err Pct Error of 4 Week Lagged Forecast

 ((4 Week Lag Forecast - Adjusted History)/Adjusted History) 

5 Week Lag Forecast Forecast as of 5 Weeks ago

6 Week Lag Forecast Forecast as of 6 Weeks ago

7 Week Lag Forecast Forecast as of 7 Weeks ago

8 Week Lag Absolute 
Dev

Absolute Deviation of 8 Week Lagged Forecast 

(abs(8 Week Lag Forecast - Adjusted History)) 
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Series Description

8 Week Lag Absolute 
Pct Err

Absolute Pct Error of 8 Week Lagged Forecast 

(abs(8 Week Lag Forecast - Adjusted History)/ Adjusted History) 

8 Week Lag Forecast Forecast as of 8 Weeks ago

8 Week Lag Pct Err Pct Error of 8 Week Lagged Forecast 

((8 Week Lag Forecast - Adjusted History)/Adjusted History) 

9 Week Lag Forecast Forecast as of 9 Weeks ago

Abs % Error Absolute % Error for Fit Forecast

Abs Deviation Absolute Deviation for Fit Forecast

Adjusted History Final History data including adjustments

Base Override Manual Override on Sales Forecast

Baseline Forecast Analytical Sales Forecast Including User Simulations

Booking Req Qty Req 
Date

Booking History Requested Quantity Requested Date

Booking Book Qty 
Book Date

Booking History Booked Quantity Booked Date

Booking Book Qty Req
Date

Booking History Booked Quantity Requested Date

Booking Req Qty Book
Date

Booking History Requested Quantity Booked Date

Demand Class 
Destination Key

Demand Class Destination Key

Demand Priority Demand Priority

EBSPRICELIST0 to 
EBSPRICELIST129

Price lists
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Series Description

Final Approval Final Approved if Checked

Final Approved By User who finally approved the forecast

Final Forecast Final Forecast 

History Historical Actual Sales/Shipment

History Override Historical Manual Override on Sales

Item Destination Key Item Destination Key

Mean Absolute Pct Err Mean Absolute Pct Err

Organization 
Destination Key

Organization Destination Key

Pct Bias Pct Bias

Relative Err Relative Err

Return History Returns History

Return History Site 
Source Key

Returns History Site Source Key

Root Mean Squared 
Err

Root Mean Squared Err

Sales Channel 
Destination Key

Sales Channel Destination Key

Shipping Req Qty Req 
Date

Shipping History Requested Quantity Requested Date

Shipping Ship Qty Req
Date

Shipping History Shipped Quantity Requested Date

Shipping Ship Qty 
Ship Date

Shipping History Shipped Quantity Shipped Date
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Series Description

Simulation Analytical Re-Forecast Triggered by a User Simulation

Site Destination Key Site Destination Key

This is a list of the series for Configure to Order

Series Description

Archived Consensus 
Total Demand

Consensus Total Demand for each of the most recent 13 historical 
weeks.

BOM Eff End Date Effective end date of the option

Sourced from Oracle e-Business Suite.

BOM Eff Start Date Effective start date of the option.

Sourced from Oracle e-Business Suite.

Consensus Forecast Weighted combination of the Final Forecast, Sales Forecast, and 
Marketing Forecast. Oracle Demantra Sales and Operations Planning 
series, available to Oracle Demantra Demand Management.

Consensus Forecast 
Amount

Monetary value of Consensus Forecast

Calculated: Consensus Forecast * Item price

Consensus Total 
Demand 

Demand represented by the sum of Final Forecast Dependent 
Demand and Consensus Forecast of an item.

Calculated: Final Forecast Dependent Demand + Consensus Forecast

Consensus Total 
Demand Amount

Monetary value of Consensus Total Demand 

Calculated: Forecast Dependent Demand Amount + Consensus 
Forecast Amount

Constrained Forecast Indicates how much of the consensus demand can be filled given 
supply chain constraints. Oracle Demantra Sales and Operations 
Planning series, imported from Oracle Advanced Supply Chain 
Planning or Oracle Strategic Network Optimization, available to 
Oracle Demantra Demand Management.
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Series Description

Dep Demand Existing Dependent demand calculated based on series Plng Pct Existing.

Calculated: Plng Pct Existing of item* If Parent = BaseModel, 
Consensus Forecast of Parent. Otherwise, series Final Forecast 
Dependent Demand of Parent.

Dep Demand History Dependent demand calculation based on Plng Pct History.

Calculated: Plng Pct History of item* (If Parent = BaseModel, 
Consensus Forecast of Parent). Otherwise, series Final Forecast 
Dependent Demand of Parent.

Final Forecast Amount Monetary value of Final Forecast

Calculated: Final Forecast * Item price

Final Forecast 
Dependent Demand

Based on the override and Forecast Dependent Demand

Calculated: Use Forecast Dependent .Demand.Override; if it is null, 
use Forecast Dependent Demand

Final Forecast 
Dependent Demand 
Amount

Monetary value of Final Forecast Dependent Demand

Calculated: Final Forecast Dependent Demand * Item price

Final Plng Pct Final planning percentage based on series Plng Pct Choice. Value can 
be overriden by series Plng Pct Override.

Use Plng Pct Override; if it is null, use Plng Pct Choice

Final Plng Pct 
Aggregated 

Final Plng Pct at levels higher than Item/Org

Calculated: Server expression

Forecast Dependent 
Demand

Based on series Final Plng Pct.

Calculated: Final Plng Pct * If Parent = BaseModel, Consensus 
Forecast of Parent. Otherwise, series Final Forecast Dependent 
Demand of Parent.

Forecast Dependent 
Demand Override

Override of the item's Forecast Dependent Demand

Manual entry
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Series Description

 Dependent History Historical dependent demand for the default History series 

Default is Shipping History, requested items, shipped date

Loaded at levels PRD for Item, TIM: for Day, ORG for Organization, 
GEO for Site, CHN for Sales Channel, and DCS: Demand Class

History series (seeded) Historical dependent demand for the series

- Dependent Booking booked items booked date

- Dependent Booking requested items booked date

- Dependent Booking booked items requested date

- Dependent Booking requested items requested date

- Dependent Shipping requested items shipped date (default)

- Dependent Shipping shipped items requested date

- Dependent Shipping requested items requested date

Loaded at levels PRD for Item, TIM: for Day, ORG for Organization, 
GEO for Site, CHN for Sales Channel, and DCS: Demand Class

 For each seeded history series, there is a corresponding dependent 
demand series. For example, seeded history series Booking - booked 
items - booked date corresponds to dependent demand series 
Dependent Booking - booked items - booked date.

Marketing Forecast Forecast from Marketing Department. Oracle Demantra Sales and 
Operations Planning series, available to Oracle Demantra Demand 
Management.

MAPE CTO Mean Absolute Percentage Error used for Forecast Accuracy Statistic

Calculated: Results of the MAPE CTO procedure that calculates the 
accuracy statistics for Consensus Total Demand.

Calculatedsum(abs(Total History - Archived Forecast))/sum(History)

Plng Pct Existing Planning percentage from the source

Sourced from Oracle e-Business Suite
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Series Description

Plng Pct History Planning Percentage calculated based on the sales history of items 
and their parents.

Calculated: Averaged over the number of periods in parameter 
CTO_HISTORY_PERIODS, default is 52.

Total(History Dependent Demand over CTO_History_Periods) / If 
Item's Parent = BaseModel, Total(History of Parent over 
CTO_History_Periods). Otherwise, Total(History Dependent Demand
of Parent overCTO_History_Periods)

Plng Pct Choice Planning percentage used to calculate Forecast, Dependent Demand, 
and Final Forecast Dependent Demand.

Select from dropdown list, stored in paraeater 
CTO_PLANNING_PERCENTAGE. Valid values

• Pln Pct Existing

• Plng Pct History

• Multiple: Displays at higher levels when items in lower levels 
have different choices.

Plng Pct Override Override of planning percentage value from series Plng Pct Existing, 
Plng Pct History, or Plng Pct Forecast.

Manually entered.

Quantity Per Parent Number of this item used for one parent. 

Sourced from Oracle e-Business Suite.

Sales Forecast Forecast from Sales Department. Oracle Demantra Sales and 
Operations Planning series, available to Oracle Demantra Demand 
Management.

Service Parts Forecasting Series
The following table displays the series used by Service Parts Forecasting.
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Series Name Definition

SPF Analytical Forecast Archive 1 Analytical forecast generated and archived for
1 forecasting cycles prior to the current cycle.

SPF Analytical Forecast Archive2 Analytical forecast generated and archived for
2 forecasting cycles prior to the current cycle.

SPF Analytical Forecast Archive3 Analytical forecast generated and archived for
3 forecasting cycles prior to the current cycle.

SPF Analytical Forecast BIAS % Accuracy measure that indicates whether the 
forecast is above or below demand. Calculated
by comparing shipments to SPF Analytical 
Forecast.

SPF Analytical Forecast Bias % 1 Month lag Bias of the analytical forecast one month into 
the future.

SPF Analytical Forecast MAPE 1 Month lag Accuracy of the analytical forecast one month 
into the future.

SPF Analytical Models Series displaying which analytical models 
were used to generate the Spares forecast.

SPF Analytical Models Min For Internal Use. Displays whether different 
models were used to forecast different 
combinations under the level displayed in 
worksheet.

SPF Analytics Forecast MAPE Accuracy measure that indicates how 
accurately the forecast matches demand. 
Calculated by comparing shipments to SPF 
Analytics Forecast.

SPF Average Demand Indicates the average historical demand for a 
spare/org. Calculated by the proport 
mechanism.

SPF Baseline Forecast Latest forecast generated by the analytical 
engine.

SPF Best Forecast Series displays whether calculated or 
analytical forecast is more accurate.
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Series Name Definition

SPF Calculated Forecast Latest forecast generated by multiplying 
install base under contract and final failure 
rate %. This series' values will automatically 
be updated when SPF Install Base Final and 
SPF Failure Rate % Final are modified.

SPF Calculated Forecast Archive1 Analytical forecast generated and archived for
1 forecasting cycles prior to the current cycle.

SPF Calculated Forecast Archive2 Analytical forecast generated and archived for
2 forecasting cycles prior to the current cycle.

SPF Calculated Forecast Archive3 Analytical forecast generated and archived for
3 forecasting cycles prior to the current cycle.

SPF Calculated Forecast BIAS % Accuracy measure that indicates whether the 
forecast is above or below demand. Calculated
by comparing shipments to SPF Calculated 
Forecast.

SPF Calculated Forecast Bias % 1 Month lag Bias of the calculated forecast one month into 
the future.

SPF Calculated Forecast MAPE Accuracy measure that indicates how 
accurately the forecast matches demand. 
Calculated by comparing shipments to SPF 
Calculated Forecast.

SPF Calculated Forecast MAPE 1 Month lag Accuracy of the calculated forecast one month 
into the future.

SPF Child Spares For Internal Use. Contains child information 
for Spares BOM.

SPF Consensus Forecast The consensus forecast values imported into 
Demantra. Based on the forecast made at Base 
Model/All Orgs.

SPF Demand Type For Internal Use. Contains demand type 
information for Spares BOM.

SPF Depth For Internal Use. Contains Spares BOM 
information regarding depth in BOM.
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Series Name Definition

SPF Engineering Estimated Failure Rate % A manual estimate of the Failure Rate for a 
new part.

SPF Engineering Estimated Failure Rate % 
MAPE

MAPE measure of last three months, 
comparing calculated forecast based on SPF 
Engineering Estimated Failure Rate %.

SPF Failure Rate % Calculated Result of the failure rate calculation.

SPF Failure Rate % Calculated MAPE MAPE measure of last three months, 
comparing calculated forecast based on SPF 
Failure Rate % Calculated.

SPF Failure Rate % Final Failure rate value used for propagation and 
calculation. Based on Override, Calculated, 
and Engineering Estimates. When the value of
this series change, the change propagates to 
the SPF Calculated Forecast series.

SPF Failure Rate % Generation Method Indicates whether the calculated or the 
statistical forecast will be used in the SPF Final
Forecast series.

SPF Failure Rate % Override Manual override of failure rate calculation, 
displayed as a percentage.

SPF Final Forecast Forecast series that will be exported to other 
systems. Generated by taking into account 
user overrides and selected forecasting 
method. User overrides are applied if 
available; otherwise selected method is used.

SPF Final Forecast Archive1 Analytical forecast generated and archived for
1 forecasting cycles prior to the current cycle.

SPF Final Forecast Archive2 Analytical forecast generated and archived for
2 forecasting cycles prior to the current cycle.

SPF Final Forecast Archive3 Analytical forecast generated and archived for
3 forecasting cycles prior to the current cycle.

SPF Final Forecast Bias % 1 Month lag Bias of the final forecast one month into the 
future.
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Series Name Definition

SPF Final Forecast MAPE 1 Month lag Accuracy of the final forecast one month into 
the future.

SPF Forecast MAPE (In Sample) In Sample accuracy measure, generated by the
analytical engine.

SPF Forecast MAPE (Out of Sample) Accuracy measure that indicates how 
accurately the forecast matches demand. 
Calculated by comparing shipments to SPF 
Final Forecast.

SPF Forecast Method Indicates whether to use either the analytical 
or the calculated forecast to drive final 
forecast. Default is Analytical.

SPF Forecast Method Min For Internal Use. Displays whether different 
forecast methods are configured for different 
combinations under the level displayed in 
worksheet.

SPF Forecast Override Override value that serves as the final 
forecast.

SPF Forecast Volatility Forecast volatility metric.

SPF Install Base Final Value used to drive calculated forecast. In 
history will display historical values while in 
the future will display the forecast for install 
base. Install base overrides will supersede 
historical and forecasted values.

SPF Install Base Forecast Displays future forecast associated with install
base under contract. When the value of this 
series changes, the change will be propagated 
to the SPF Calculated Forecast series.

SPF Install Base Override Allow user override of install base 
information.

SPF Install Base Simulation Displays values associated with simulated 
install base under forecast.
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Series Name Definition

SPF Install Base Under Contract Amount of Base Model units being supported 
for a specific Organization.

SPF Item Shipment Final Displays the final shipments. Displays user 
override if available, otherwise shows 
imported shipments.

SPF Item Shipment Override User override of shipments imported into 
Demantra.

SPF Item Shipments Stores the item shipments imported into 
Demantra.

SPF Item Usage Stores the item usage imported into 
Demantra.

SPF Item Usage Final Final usage value. Displays user override if 
available, otherwise shows loaded shipments.

SPF Item Usage Override User override of item usage imported into 
Demantra.

SPF Latest Rev Displays the latest revision information in 
worksheets using Spares BOM.

SPF Parent Install Base For Internal Use. Propagates Install Base 
information to Spares BOM child nodes.

SPF Parent Spares For Internal Use. Contains parent node Install 
Base information in Spares BOM. Used in data
propagation.

 SPF Simulation Latest forecast generated running a 
simulation.

Series that Support Asset Intensive Planning Integrations
The series in this section are provided to support Demantra integration with Oracle 
Complex Maintenance Repair and Overhaul (cMRO) and/or Enterprise Asset 
Management (eAM). 

For more information about this integration, refer to "Oracle Demantra Integration with 
Asset Intensive Planning Applications" in the Oracle Demantra Implementation Guide. 
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Series Name Description

Available Resource Plan Available resource capacity stored by plan.

Beginning On Hand Defectives Beginning defectives inventory level.

Constrained Forecast Archived Archived constrained forecast. 

Fleet Flight Hours Historical and projected usage hours 
associated with a fleet.

Fleet Size Historical and projected fleet size.

Fleet Times Used Historical and projected number of distinct 
uses associated with fleet.

Intransit Defectives Current intransit inventory level (defectives).

Material Purchase Cost Cost of purchased materials.

Material Repair Cost Material repair cost.

Material Resource Cost Material resource cost.

Personnel in Organization Number of persons in organization. Can be 
used to drive non-maintenance forecast.

Plan Production Cost per Unit Material production cost per unit stored in 
Plan Scenario dimension.

Plan Purchase Cost per Unit Material purchase cost per unit stored in Plan 
Scenario dimension.

Plan Repair Cost per Unit Material repair cost per unit stored in Plan 
Scenario dimension.

Plan Resource Cost per Hour Resource cost per hour stored in Plan Scenario
dimension. 

Production Cost per Unit Material production cost per unit stored in 
fact data.
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Series Name Description

Purchase Cost per Unit Material purchase cost per unit stored in fact 
data.

Repair Cost per Unit Material repair cost per unit stored in fact 
data.

Repair Plan Planned repairs. 

Required Capacity Archived Archived repair capacity forecast.

Required Resource Plan Required resource capacity required to meet 
demand.

Resource Cost per Hour Resource cost per hour stored in fact data.

SPF Fleet Size Historical and projected fleet size stored on 
SPF dimension.

SPF Fleet Times Used Historical and projected number of distinct 
uses associated with fleet stored on SPF 
dimension.

SPF Fleet Usage Hours Historical and projected usage hours 
associated with a fleet stored on SPF 
dimension.

SPF Item Usage Final Usage information striped by work order 
attributes.

SPF Total Independent Demand Total independent demand used to generate 
failure rates. For internal use only.

SPF Weighted Failure Rates Failure rates weighted using independent 
demand. Only to be used for exporting failure 
rates.

SPF Work Order History Aggregated work orders. Work orders are 
striped by several attributes and aggregated to
serve as independent demand for service part 
BOM.



Demand Management Levels and Series    A-25

Series Name Description

Total Demand Total of material requirements used to feed 
Inventory Optimization.

Work order Demand Projected material and resource demand for 
work orders by plan.

Work order Demand Approved Projected material and resource demand for 
work orders with accepted plans.

Work order Demand Archive Snapshot of work order demand stored 
without plan context. Information is used to 
drive work order accuracy calculation.

Work order Demand MAPE Calculated MAPE measure for work order 
demand. It is calculated by comparing Work 
Order Demand Archive and Adjusted History 
series.





Index-1

 
Index

A
Absolute Deviation view, 4-4
approval workflows, 5-5, 5-12
approving forecasts, 4-11
Archive Forecast workflow, 5-5
Archive Forecast workflow, 5-2

B
base time unit

configuring, 5-13
Business Modeler, 5-1, 5-3, 5-19

C
Collaborator Workbench, 2-4, 4-1, 5-17
collecting and downloading data, 2-2
configuration steps, 5-1
configure to order, 2-6
configure to order worksheets, 4-21
configuring

approval workflows, 5-5, 5-12
base time unit, 5-13
item short name, 5-17

configuring Demand Management, 5-1
configuring users, 5-2
controlling maximum sales dates, 5-18

D
Demand Administrator, 2-3
Demand Analysis group, 5-5
Demand Analysis worksheet, 2-3, 4-2

business data, 4-13
Demand Tracking graph, 4-10
Demand Tracking table, 4-9
Detail Demand Analysis embedded 
worksheet, 4-10

Demand Analyst, 2-3
Demand Forecast workflow, 5-2, 5-5, 5-6
Demand Management

configuring, 5-1
description, 1-1
overview, 2-1
process overview, 1-2

Demand Management administrator, 2-2
demand management process, 2-2
Demand Planner Web

forecasting, 3-2
demand priority, 2-3, 4-11
Demand Tracking graph, 4-10
Demand Tracking table, 4-9
Detail Demand Analysis Embedded Worksheet, 
4-10

E
EBS Input series group, 4-13
Eight week lag forecast, 4-4
EP_Load process, 5-2
EP_LOAD process, 5-18

F
filtering user data, 5-3
Final Approval series, 5-5
Final Approve By series, 5-5



Index-2

Forecast Accuracy series group, 4-7, 4-13
forecast and metrics view, 4-4
forecasting

configure to order, 2-6
product family, 2-5
service parts, 2-23

Forecast Percentage Error view, 4-5
forecasts, 4-4

approving, 4-11
generating, 2-3
managing and approving, 2-3
uploading, 2-4

Forecast series group, 4-13
Four week lag forecast, 4-4

G
generating forecasts, 2-3

H
Historical Demand series group, 4-8, 4-13

I
integration profiles, 5-18
item description, 5-17
item short name, 5-17

L
levels, A-1

service parts forecasting
available levels, A-4

SPF general levels, A-5
LOB. See multiple lines of business, 2-4

M
mandatory component, 2-6
maximum sales dates, 5-18
MaxSalesGen parameter, 5-19
MaxSalesGen parameter, 5-2
model, 2-6
modifying sales override values, 4-10
multiple lines of business, 2-4

N
new product launches, 4-17

new product launch workflows, 4-19

O
option, 2-6
option class, 2-6
Oracle Advanced Planning Suite, 2-2
Oracle Collaborative Planning, 2-2
Oracle Demantra Demand Management. See 
Demand Management, 1-1, 2-1
Oracle Global Order Promising, 2-2
Oracle Inventory Optimization, 2-2
overview of Demand Management, 2-1
overview of the configuration process, 5-1

P
Planning Group workflow, 5-2, 5-5, 5-7
planning percentage, 2-6
process, demand management, 2-2
product family forecasting, 2-5
Promotions Effectiveness

forecasting, 3-2

R
request

simulation
canceling, 3-5
submitting, 3-2
viewing, 3-4

S
Sales series group, 4-8, 4-13
security, 5-2
sending notifications, 2-3
series, 4-7, A-10

services parts planning, A-17
service parts forecasting, 2-23

series, A-17
worksheets, 4-25

service parts planning
overview, 2-23

simulation
canceling, 3-5
running, 3-2
viewing queue, 3-4

SPF: Analyze Forecast Latest Revision 



Index-3

worksheet, 4-26
SPF: Analyze Forecast Organization Latest 
Revision worksheet, 4-26
SPF: Analyze Organization Base Model Spare 
worksheet, 4-27
subset forecasting

overview, 2-26
system parameters, 5-19

T
time bucket start day, 5-13
time resolution, 5-2
Twelve week lag forecast, 4-4
typical tasks, 1-2

U
uploading forecasts, 2-4
user configuration, 5-2
user groups, 5-1
users, 5-1

W
Waterfall Analysis worksheet, 2-3, 4-2

Absolute Deviation view, 4-4
business data, 4-7
Forecast and Metrics view, 4-4
Forecast Percentage Error view, 4-5

Workflow Manager, 5-7
workflows, 5-12

Archive Forecast, 5-2
configuring, 5-5
Demand Forecast, 5-2
new product launch, 4-19
Planning Group, 5-2

worksheets
configure to order, 4-21
Demand Analysis, 2-3
overview, 4-1
service parts forecasting, 4-25
SPF: Analyze Forecast Latest Revision, 4-26
SPF: Analyze Forecast Organization Latest 
Revision, 4-26
SPF: Analyze Organization Base Model Spare, 
4-27
Waterfall Analysis, 2-3




	Oracle Demantra Demand Management User's Guide
	Preface
	Introduction to Demand Management 
	Introduction
	What is Demand Management?
	Why Manage Demand?
	Typical Tasks in Demand Management

	Demand Management Overview
	Oracle Demantra Demand Management Overview
	Product Family Forecasting Overview
	Configure to Order Overview
	Service Parts Planning and Service Parts Forecasting Overview
	Subset Forecasting Overview

	Running Simulations
	Overview of Forecasting
	Viewing Forecast Details
	Running Simulations
	Checking the Simulation Queue
	Canceling a Simulation

	Demand Management Worksheets
	Worksheets Overview
	New Product Launch Management Worksheet
	Configure to Order Worksheets
	Service Parts Forecasting (SPF) Worksheets

	Configuring Demand Management
	Overview of the Configuration Process
	Configuring Demand Management Users
	Configuring Approval Workflows
	Configuring the Base Time Unit and Time Bucket Start Day
	Configuring the Item Short Name and Description
	Controlling System and Engine Maximum Sales Dates
	Purging Historical Sales Data

	Demand Management Levels and Series
	Demand Management Levels
	Demand Management Series

	Index


